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Set Analysis

In BusinessObjects Set Analysis you work sets and export lists.
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Sets
When are sets useful?

Sets allow you to define complex selections and custom groupings of
customers, products or other individual items in a database.
Sets allow you to identify and target groups of clients based on criteria that
source data allow you to specify. For instance, you may want to select all
clients living in a particular geographic area who own homes, are below a
certain age, and have children.
Sets have the following attributes:
•
•
•
•
•
•
•
•

Sets contain items based on a single subject that determines the primary
key.
Sets are uniquely identified by name, folder and author.
Sets can have a description.
Sets have a last modified date.
Sets are allocated to a folder.
Sets contain a count of the members if the set has been built. Otherwise
it just has a definition.
Sets contain members that can accumulate a score based on the
weightings you define.
Sets can be processed from many steps, each step based on a single
table or view.

The subject defines the central theme for the sets which are based on it. A
set can contain data for only one subject; for example, customers, accounts
and products. In the context of a customer subject, you can define sets that
include conditions based on the various tables and views that describe the
customer entity.
Customers can be classified, analyzed and treated in different ways using
set techniques. You can create broad or specific sets to categorize customers
in ways that are relevant. The following is an example of the link between
subject area, sets and subsets:

10

Levels

Example

Subject Area

Customer

Set Group

Single Set

Set

Collector

Subject

Member, Joiners, Leavers

SAP BusinessObjects Set Analysis User Guide

Sets
When are sets useful?

Individual Sets and Set Groups reside in a Set Analyzer repository. Individual
Sets can belong to Set Groups, and Set Groups generally contain more than
one individual set. Grouping sets can be a useful way of classifying and
organizing sets into meaningful categories to facilitate analysis.
Sets can be scheduled. Refer to the Dashboard Builder documentation for
more details.

When are sets useful?
Sets help you understand how groups and segments contribute to overall
performance by simplifying and accelerating the data segmentation process.
Sets can help you address the following types of business questions:
•
•
•
•
•
•
•

turnover
cross-selling
customer scoring (ranking)
data sampling
segment interaction
list management
marketing stratification

Viewing sets in Set Analysis
You can perform the following functions from the Sets tab of Set Analysis:
•
•
•
•
•
•
•
•
•

View the list of existing sets
Delete a set
Name and describe sets
Define the current set
Create a set
Create a folder
Define set scope
Access and create Groups
Create taxonomic groups and rebuild (processing) groups
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Creating a set folder in Set Analysis
A folder contains sets and groups. Folders enable you to manage your sets
effectively.
Note:

You cannot delete a folder if it contains sets. To delete a folder, you must
first delete the sets it contains.
1. In Set Analysis > Sets, click Add.
2. Select New Folder.
3. Enter the following information:
• Name
• Description
• Folder audience (indicates which user groups can access the folder
and the sets it contains)
4. Click Apply.
The new folder is displayed in the list of available sets, folders and groups.

Creating a group in Set Analysis
1. In Set Analysis > Sets, click Add.
2. Select New Group.
3. Designate the following attributes for the group:
• name
• the folder to which the group belongs
• type: distinct, taxonomic or rebuild
4. Click Apply.
The new group appears in the list of available sets, folders and groups.
Related Topics

• Set group types
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Set group types
The set group types are:
•
•
•

Distinct
Rebuild
Taxonomic

Distinct groups in Set Analysis
Distinct Groups allow you to group sets and ensure that there is no overlap
between them. Set Analysis creates a list of members that removes any
duplication. If you create several mailing campaigns, you want to ensure that
no contact is mailed more than once. The distinct model allows you to define
a priority for each set and ensure that each member is allocated to only one
set.
Once the sets have been added to the group it is ready for processing. The
group is processed on creation, after one of the following events:
•
•
•
•

a set is added to or subtracted from the group
the build order is changed
the display order is changed
one of the sets within the group is refreshed. In this case, the group is
refreshed automatically.
Note:

Refreshing a set that is part of a distinct model can be a lengthy process,
because the group is refreshed as a part of the refresh process. The
system displays a warning dialogue box before the group is reprocessed.

Selecting a distinct group in Set Analysis
1. In Set Analysis > Sets do one of the following:
• Click Add > New Group to create a group . Select the new group and
click Edit.
• Select a group and click Edit.
2. Add sets to the group.
3. Optionally, reorder the sets according to:
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•

•

Build Order: changes the order in which the sets are built. The order
in which sets are listed as component items for a group determines
the priority order for the calculation of distinct items. The group is made
up of all the items from the first set, plus the items from subsequent
sets not already been allocated to the group. The first set has the
highest priority.
Display Order: changes the display order for the sets.

Rebuild groups in Set Analysis
This is a group of sets with or without similar content that can be refreshed
at a defined time interval. At refresh time, the dependencies are taken into
account.
A rebuild group can be scheduled and all sets under it are taken into account.
For example, if set A is dependent on Set B before it is refreshed, rebuild
type group takes care of that.
Rebuild groups allow you to group sets to be processed and reprocessed
together. For example, if you have processed a final set which has been
processed from several other sets, you need to reprocess all the other sets
first, and ensure that each dependent set has finished processing, before
reprocessing the final set.
This can be a lengthy task. Building a processing group allows you to group
all the sets together and let Set Analysis decide which sets to process in
which order.
Note:

If any sets within the group are rebuilt manually, outside of the context of the
group, the system reprocesses the whole group.

Building a rebuild group
1. In Set Analysis > Sets do one of the following:
• Click Add > New Group to create a group . Select the new group and
click Edit.
• Select a group and click Edit.
2. On the Add Set page, add and remove sets.
3. Click OK.
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Note:

Child sets are automatically added to the group to which their parent sets
are assigned. Parent sets are placed above their child sets in the
processing order.
4. Click Process Group to process the group.

Taxonomic groups in Set Analysis
This is also a group of set for classification and analysis purpose. Taxonomic
groups cannot be scheduled but can be used as a way of classifying sets in
all places where sets can be selected in a tree list. These groups are also
used in group benchmark analytic. For example, if you want to group all sets
related to high income spenders then you can define the group as taxonomic
and add the relevant sets to the group.

Creating a set in Set Analysis
Creating a set involves two steps:
•
•

Defining a set
Building a set

Defining a set
1. In Set Analysis > Sets, click Add.
2. Select New Set.
3. Enter the name of the new set.
Each set must have a name that identifies it for later operations. The
name must be unique in the folder. If you want to use the same name for
two sets, you must allocate them to different folders.
4. Select a folder.
5. Select a build strategy for the set:
• System default
• Stepwise only
• Combination (where possible)
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6. Select the Scope of the set.
Public sets are visible to all users and private sets are available only to
the person who created them. When you create a set and allocate it to a
public folder, the scope is defined as public. When you create a set and
allocate it to a private folder, the scope is defined as private.
7. Add any descriptive notes about the set, and assign one of the following
descriptions if appropriate:
• Frozen
If you select Frozen, neither the set owner nor any other user can
change or reprocess the set. To change or reprocess the set in the
future, deactivate this field. This flag is useful when creating a snapshot
set that must not be reprocessed, for example, a specific mailing
campaign.
•

External
Selecting External indicates that the set was created by an external
action. Use the option if set membership is calculated and managed
by some other application. The other application can create a set and
store it within the repository.

•

Terminal
Select Terminal so that the set is not used as the starting point for
any other set.
Note:

You cannot use a terminal set within the Visual sets view.
8. Specify whether the set is Dynamic or Static:
• Static sets are snapshots that store data of a given moment. Static
sets are built once, and their membership does not change over time.
• Choose Dynamic from the list to attach a calendar type to the set.
Dynamic sets permit the membership to change based on changes
in the source data. Dynamic sets are generated between two dates,
based on a specific period of time. The history of dynamic set
membership can also be preserved and used for time-based analysis.
9. If you are creating a Dynamic set, enter the following details:
• the time interval for set rebuild
• the type of dynamic set: Temporal, Limited Temporal, or Snapshot
• rebuild information
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Dynamic sets are typically rebuilt according to the periods associated
with refresh time interval or calendar selected for the set. The default
is to prevent multiple processing in the current period as you may not
normally want to rebuild the set twice in the same period.
•

Allow Auto-fill
For new sets, the period associated with the first build is called the
base period. For subsequent builds, the most recently ended period
is associated with the set. However, if you activate Allow Auto-fill,
the associated period comes after the period for the most recent build.
Thereafter, each build increments the active period for that set. If the
set is dynamic and Allow Auto-fill is activated, the AutoFill / Rollback
button in Sets view is enabled.
Selecting Stop at current period causes normal behavior to be
adopted once the auto increment rebuild period is equal to the current
period.

10. Click Apply Changes to save the new set. Once you have created the
set definition, you must add data to it.
Related Topics

• AutoFill in Set Analysis
• Building a set

AutoFill in Set Analysis
The Allow Auto-fill option in the set Attributes panel is used to process a
set from a selected base date contained in predefined calendar to a specific
end date, or for n periods from the base date. AutoFill is enabled only if the
set is dynamic and if you activate Allow Auto-fill in the set's attributes
properties. AutoFill can back-fill the dynamic membership of a set.
For new sets, the period associated with the first build is called the base
period. For subsequent builds, the most recently ended period is associated
with the set. However, if you check Allow AutoFill, the associated period
comes after the period for the most recent build. Thereafter, each build
increments the active period for that set. If the set is dynamic and Allow
Auto-fill is activated, the AutoFill / Rollback option appears on the set
Content panel.
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Once the AutoFill parameters have been defined, the set can be processed.
Note:

•
•

AutoFill can only be used for dynamic sets.
The dates you can choose to AutoFill to are determined by the selected
base date and whether the Stop at Current Period option is activated
in the set's properties. AutoFill Summary This provides summary data
such as start and end periods and total number of periods.

Building a set
Once you have defined a set, select it in the list of available sets. You can
now add data by building the set. Building the set involves:
•
•

adding data
building the set with the data

Related Topics

• Visual data views in Set Analysis
• Visual sets in Set Analysis
• Using Freehand SQL
• Defining an event analysis in Set Analysis
• Importing keys into sets from a csv file

Visual data views in Set Analysis
A new set is created empty. An empty set needs to have members added
to it before it can be used. You can fill the set in the Visual Data view. You
can perform the following functions from the Visual Data view:
•
•
•

•
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Navigate through the database using the list of universe objects to locate
the categories of data required to fill the current set.
Create your own object lists for data navigation.
View the contents of the database categories in the detail windows on
the right of the view. These detail windows provide information about the
content of the categories and how they relate to other categories.
View the components of a category by moving it to the top detail window.
When you move a category to the top window, its sub-categories appear
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•
•

in the lower window. Move a category to the upper window by
double-clicking it in the lower window.
View the relationship between the upper and lower window categories
as indicated in the list of objects.
View the number of members currently in the set.

Using a Visual Data view
1. In the Set Building Steps pane of the Content tab click Add.
2. Select Visual Data.
Creating a visual data view
Once you have created and saved a set, you can add members to it in the
Visual Data view. The Visual Data view contains a hierarchy of segments
for members on which you can drill down.
1. Click Add under Set Building Steps and select Visual Data.
Once you have created and saved a set, you can add the data field to it.
When you select the Visual Data option, a list of object is displayed in the
left-hand pane. The list of objects displays dimensions and measures
available in the database for creating set content.
2. Select Visual Data.
3. Select and add a dimension or measure.
Note:

Select a count for each dimension. This step is required before performing
an operation on your set.
4. To remove the dimension or measure, click the left-facing arrow key.
When you select a measure, the Added Field Condition window opens.
If you select a dimension, you must check Yes/No Condition and click
OK for the window to appear.
The Added Field Condition window allows you to define the filter and
specific condition for the dimension. For example, use the field condition
to create a set of people with Age (dimension) that is greater than 45
(filter, condition).
Defining a condition is optional. If you do not want to define a condition,
check Yes/No Condition to deactivate all filters and view all values for
the selected dimension.
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If the dimension is Date type, then the field condition window allows you
to enter calendar details.
5. Select Relative or Floating date:
• Select floating to specify the floating period.
• Select relative to enter a specific date.
6. If you selected dates with a Between condition, select an end period
which can be either relative or floating.
7. Select a filter option. The description is automatically displayed.
8. Click OK.
9. The filter condition is displayed on the selected dimension on the main
page.
10. Select estimates only or exact count.
11. To filter a dimension with a numeric value, select the dimension in the
set building area of the page. The filter function button appears.
12. Click the filter function button, and enter all details for the set content.
13. Click Next.
14. Enter a description of the step to be processed, for reference purposes.
15. Allocate points for scorecarding using the + or - buttons, or by typing an
integer value in the Additional Score box.
You can allocate a score to each step or process operation. For example,
select Tennis Players and award 1 point. Select Contacts in New York,
and award a score of 2, and select Contacts spending more than $200
and award a score of 4. Each member can exist only once in a set, but
if a member is selected for more than one reason, then the scores are
accumulated on a member-by-member basis. In this example, someone
who matches on all three conditions accumulates a score of 7.
The score must be an integer and can be positive or negative. Limits for
number size vary by database and installation. Typically, the score value
is not very large.
16. Optionally, define sampling parameters.
Related Topics

• Sampling in Set Analysis
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Sampling in Set Analysis
Sampling allows you to refine a set selection by defining the exact
characteristics of the output. Selection focuses on defining the criteria that
defines the output. Normal selection, however, can produce too many
members.
If you select a set of customers of a certain age, gender, and income from
a database containing 3,000,000 customers, you may produce a set of
270,320 customers. If you want to target only 10,000 people, you can split
them into five cells of 2,000 people to test different treatments and use the
sampling module to create random sampling and ranked attributes.
You can stratify each selection into groups to produce skewed samples. For
example, base the data on a 60/40 male/female split and then use skewed
samples to target 25% male and 75% female.
Set Analysis provides four specific types of sampling scenario:
•

•

•

•

Random sample creates a different result set each time it is created. For
example, use it to select 100 people randomly from the sample frame. If
you select Random, activate either Sample Size to show the numbers
used to process the sample, or Sample % of Total to count the sample
as a percentage of the total.
Ranked takes the top n number of customers from the sample. For
example, use it to select the top 100 people from the sample frame. Sort
on the columns matching the field to be used for the ranking, then click
OK. You can sort the column in either ascending or descending order to
specify whether you choose the top n or bottom n. Descending order
produces the top n.
Stratified Random sampling randomly selects customers from the sample
frame. For example, use it to select randomly 50 males and 50 females
from the set.
Stratified Ranked sampling selects a ranked selection in each category.
You can use this sampling to list the top ten people in each town in the
sample frame.

Defining a sample grouping or strata
1. Click List available objects.
2. Select the objects by which you want to group the resulting sample.
3. Click OK.
The resulting table includes the following columns:
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•
•
•
•
•
•

the data corresponding to the objects you selected for the Group Fields
option
Source Count: the breakdown of the original source, grouped by the
objects you selected
Source %: grouped source count as a percentage of the total
Sample Count: the numbers used to process the sample
Sample % of Source: the sample count as a percentage of the source
count
Sample % of Total: count as a percentage of the sample total

4. To change the Sample Count, click the value in the table and enter a new
value. Changing the values of the counts is useful when a sample is
irrelevant to the result.
5. If you selected a Ranked sample, select the ranking by clicking the button
next to the Ranked by field.
6. Sort on the columns matching the field use for the ranking, then select
OK. You can sort the column in either ascending or descending order to
specify whether you choose the top n or bottom n. Descending order
produces the top n.
7. Click OK.
The set built is displayed.

Visual data estimates in Set Analysis
Visual Data estimates allow Set Analysis to use estimates rather than getting
counts from source tables. Estimates are not as accurate as counts but can
be much quicker.
Visual Data estimates use aggregated objects to calculate subsequent counts
for objects at a lower level of an ad-hoc object tree.
Estimates on the aggregated objects differ from standard object trees because
you do not need to define them using the Object Tree creator in Set Architect.
The counts for the tree are predefined but are not calculated if you add an
object to the predefined tree.
Note:

The accuracy on calculations for estimates improves if the object being
calculated follows a predefined Object Tree. For example, if a geography
hierarchy with fast counts has been defined as Country, State, City and the
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Gender object is added to the bottom of the hierarchy, the estimate is more
accurate than for an ad-hoc assortment of objects.
Example: An ad-hoc object tree of Country, Bank and Gender all of which
have had Fast Counts calculated on an individual basis.

The country, bank and gender objects are not part of the Object Tree.
If England and Bank 1 are selected for the first two levels of the tree, when
Gender is expanded, the system finds a fast count for Gender and the
objects above it. A smart calculation is used to produce an estimate for
Gender. The estimates returned are:
Female= 4,356,808; Male = 4,218,497; Unknown = 69,156.
If the source table is queried to obtained exact counts, the result is:
Female= 4,456,448; Male = 4,128,768; Unknown = 65,536

Setting visual data estimate options
To access visual data estimate options, open the Visual Data view for edit
and click Options in the top right corner of the screen to change this option.
The following options affect the way in which estimates work:
Option

Description

Always use Source if Select the option to query the source table without
required
prompting the user.
Always use Estimates if available

Select the option to use estimates without prompting the user.

Visual sets in Set Analysis
Once you have created a set, you can add or remove members to or from
it using the database navigation facilities of the Visual Data view. You can
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also add or remove members to and from a current set from a previously
created set. You can perform the following functions from the Visual sets:
•
•
•
•

construct sets that contain members that several sets have in common
perform set mathematics on any combination of sets
manage complex exclusions based on existing sets
perform visual sets counts

The Collections list shows you the sets that have been selected for inclusion
in the Visual sets operation. You can combine sets for inclusion in the
universe by dropping them in the same collection. By dropping sets in
separate collections, they are displayed individually in the graphical universe
area. The color of each collection matches the color of the set in the universe.

Modifying visual sets
1. You add a set to a collection by selecting the set and clicking the arrow
keys to move it to a particular collection.
2. Optionally, click a collection to rename it.
3. To select the collections you can either click the diagram or click Select.
4. The Count calculates the number of members (and percentage) currently
selected from the available sets in the universe. Click Next to select the
operation you want to perform on the sets
5. Enter the Description for the Visual Set.
6. Select the Set Operation to be performed. The operations are:
• Add: adds the selected members in the sets in the universe to the
current set
• Subtract: subtracts the selected members in the sets in the universe
from the current set
• Keep: keeps the intersection of the current set and the selected
member in the sets in the universe
• Score: updates the scores for the selected members in the sets in the
universe
Note:

The first time you create a set, the default choice in the set operation is
added automatically.
7. Optionally, enter a score in the Additional Score field.
With SQL tools and selection tools in general, all matching items are
returned as equal. This is not always the case in marketing, for example,
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so you can score each selection. The scores for each selection are then
accumulated.
8. Click OK to execute the operation.
The set is added to the set list, and a graphical diagram of the operation
performed is displayed in the Step Detail pane.

Using Freehand SQL
Freehand SQL allows you to write SQL to process sets. For example, you
can create a link to a fact table or include information necessary to create
the set that is not in the dimension table.
Note:

Use the normal set operations (Start, Add, Subtract) to determine how the
results of the free hand SQL are applied to the current set. The SQL statement
can return as many columns as necessary, but one column must be named
ID. This column is used as the list of IDs with which to create the set. It is
not possible to create a set containing IDs that are not listed in the dimension
table. When you process a set from freehand SQL, any IDs that are not in
the dimension table are discarded.
1.
2.
3.
4.
5.
6.

In the Set Analysis Sets view, select an existing set or create a set.
Click Add, and select Free Hand SQL.
Type in the SQL to generate a list of keys to form the set.
Click Next.
Enter the description of the SQL process and define any additional points.
Click OK to process the SQL.

Defining an event analysis in Set Analysis
Event Analysis analyzes the membership of a dynamic set (joiners, leavers,
stayers and visitors), specifies analysis periods and uses the activity within
the set for analysis. Select defined parameters to specify the event type to
analyze.
1. Click Add in the Set Building Steps.
2. On the Event Analysis page, select the folder and the set under it. Click
the arrow to select the folder.
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3. Choose one of the following:
Option

Description

Activity

Select Activity to create an action based on activity within
the analysis period.

Summary

Select Summary to create an action based on the summary
of activity within the analysis period.

4. Specify the analysis period.
You can simply specify start and end dates, or you can use the calendar
associated with the set to specify the analysis period.
Note:

You cannot proceed until you define the Analysis Period.
The event activity depends upon whether you have selected the Activity
or Summary button.
5. Click Activity, and choose an Activity type to analyze.
Activity Type

Description

Joiner

Analyzes the selected set for people who joined the
set in the analysis period.

Leavers

Analyzes the selected set for people who left the set
in the analysis period.

Stayers

Analyzes the selected set for people always present
within the set in the analysis period.

Visitors

Analyzes the selected set for people at one time or
another in the set in the analysis period.

6. Click Summary, and construct a summary action for the analysis.
• Cycle allows you to select members based on their type of presence
with respect to the calendar periods.
• Condition allows you to set a condition for inclusion.
• Number allows you to set the number of periods over which to perform
the selection.
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•

Time Interval allows you to select the time periods to use.

7. Click Next.
8. Define the Description and Set Operation for the event.
9. Click OK.

Importing keys into sets from a csv file
The Import option allows you to import lists of keys from a .csv file. The file
must contain a column based on the key. Before you can import keys, they
must exist in the primary source table of the current subject.
The import process imports keys that exist in the dimension table for the
current subject. If a customer file contains 100 items and only 99 of the
customer primary keys exist in the customer table, then 99 items are inserted
in the set.
1. In the Set Analysis Sets view, select the set into which you want to import
keys.
The Import view appears.
2. Click Select Import File.
3. From the Open dialog box, select the file from which you want to import
keys.

If you are not sure of the file format required to import into Set Analysis
1. In Set Analysis create a set with a small number of items.
2. Choose Export from the File menu.
Note:

Do not change the default options for delimiters.
3. Create a set and import from the same file.
4. Confirm that you have imported the items into the set.
5. Open the comma separated .csv file.
Notice how the first row contains a column name. This is required for the
import to work successfully.
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Set-building options in Set Analysis
This section describes set-building actions such as:
•
•
•

AutoFill
Build
Checking for dependencies

Related Topics

• Dependencies in Set Analysis sets

Building sets in Set Analysis
The Build option in the set Content panel allows you to build the sets that
you define. It calculates based on the steps defined.
As you build the steps, the sets displaying -1 can be seen. The -1 signifies
that the step has been combined with other steps to form a single SQL
statement, which improves the set processing.
Note:

Only one SQL block can be used per set, all Visual Data and Visual Set
steps can be combined into a block, all other steps cause individual
statements to be run, sampling within a step also causes the block to be
broken.

Completing the set build in Set Analysis
Click Finish to build individual steps.
This builds the last step defined and keeps the counts from previous steps
intact. This method provides a slight improvement in processing time.

AutoFill in Set Analysis
The Allow Auto-fill option in the set Attributes panel is used to process a
set from a selected base date contained in predefined calendar to a specific
end date, or for n periods from the base date. AutoFill is enabled only if the
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set is dynamic and if you activate Allow Auto-fill in the set's attributes
properties. AutoFill can back-fill the dynamic membership of a set.
For new sets, the period associated with the first build is called the base
period. For subsequent builds, the most recently ended period is associated
with the set. However, if you check Allow AutoFill, the associated period
comes after the period for the most recent build. Thereafter, each build
increments the active period for that set. If the set is dynamic and Allow
Auto-fill is activated, the AutoFill / Rollback option appears on the set
Content panel.
Once the AutoFill parameters have been defined, the set can be processed.
Note:

•
•

AutoFill can only be used for dynamic sets.
The dates you can choose to AutoFill to are determined by the selected
base date and whether the Stop at Current Period option is activated
in the set's properties. AutoFill Summary This provides summary data
such as start and end periods and total number of periods.

Emptying a set in Set Analysis
In the set Content panel, click Empty to empty the defined sets to be built
again.

Removing a set
1. In Set Analysis, Sets, select a set from a folder.
2. Click Remove.
3. Click OK.
The selected set is deleted from the folder.

Dependencies in Set Analysis sets
In Set Analysis, to check whether the set has any dependent sets, click
Dependencies in the set Content panel.
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The Dependencies panel appears, showing a list of all sets that are
dependent on the current set. This shows you whether changes to the current
set have any effect on any other sets.

Editing a set in Set Analysis
1.
2.
3.
4.

In Set Analysis > Sets > Content, select the set universe.
Select a set.
Click Edit.
In the Content panel modify as necessary:
• To add an item selecting it in the left-hand list and click >.
• To remove an item from the list, select it and click <.
When you select an item the fast counts panel appears. Click Cancel
so that you can remove it from the list.
•

To edit the fast counts properties for an item, select it in the selected
sets list.
The fast counts properties panel appears.

• Activate or deactivate Yes/No Condition.
• Select or deselect set members.
Click Next or Attributes.
5. In the Attributes panel modify as necessary:
•
•
•

the set description
the additional score
the sampling type

6. Do one of the following:
• Click OK to save your modifications.
• Click Previous or Content to return to the Content panel.
• Click Cancel to cancel the modifications made in the edit mode and
return to the Sets panel.
Related Topics

• Configuring the Visual Data Counts analytic
• Creating a visual data view
• Creating a visual data view
• Sampling in Set Analysis
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Set membership in Set Analysis
The Membership panel displays members for the selected set. It shows the
status of stayers, joiners and leavers.
To view the membership of a set, go to Set Analysis > Sets > Membership.
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There are three major actions that you can take once you have gone through
your analysis.
•
•
•

Rules: automate some of the analysis or to track exception when data
changes
Lists: generate lists of people according to criteria.
Schedule: schedule refresh of metrics and rules

Related Topics

• Set Analysis List feature
• Defining a set list in Set Analysis

Set Analysis List feature
The List feature enables the user to get a subset of individuals and products
from a given set. A list is a powerful way to get a clear picture of your analysis.
For example, a list of people in high profile subset or list of joiners in the
Collectors set.
A list is defined by the administrator through the System Configuration section
but once you access the list, you can customize it to your needs. For example,
a list of joiners may have their customer id, age marital status and income,
which is termed as the content of the list.
There are different ways of sending a list, for example, emails, URL, to allow
better integration with operational systems like Campaign Management.
A list can be based on single or two sets. For example, you can get a list of
leavers in High Spender set to Low Spender set.
A list can be linked to Individual Profiler. The Profiler Output enables you to
profile an individual of the list. Therefore based on your List template, the
Individual analytics generates the names corresponding to the content of
the list which further allows you to get into deeper analysis for each individual.

Defining a set list in Set Analysis
As the list is generated it is displayed on the screen. This list can also be
stored on the server as a Web Intelligence document, downloaded and saved
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on the local hard drive, linked or published as a URL or sent through an
email.
You can also generate a metadata XML that was defined during the
Dashboard and Analytics setup.
1. Click Export List.
2. On the List Generation page select an output from the List.
Output is the type of file the information is saved to, and is defined by the
administrator in the Dashboard and Analytics configuration. Refer to
the Dashboard and Analytics Setup documentation for details.
3. If you select exporting to a URL, enter the URL string.
Note:

The administrator can set a default subject name or selected objects list,
which the user cannot change. Only the administrator sets the email
addresses.
4. Select the List Composition.
Use the setting to indicate whether you want to see a list of one set or a
migration which is a movement from one set to another or measures for
two sets.
5. Click Next to define the Set for the List.
6. Based on the List Composition, the set lists are displayed. The set list is
based on the combination of subject area and list composition selected
in the previous section. You can view the set list either by group or set.
If you selected single set as the list composition then you have one set
list displayed.
If you selected migration as the list composition, two set lists appear.
These set lists are source and destination sets, and indicate the movement
from the source set to the destination set.
If you select any other list composition, two set lists are displayed for
comparison.
7. Click Next to define the content of the list.
8. A list of available information is displayed. Select as many and move it
to the List content column by clicking the right arrow key. You can move
only one content head at a time.
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Once you have moved the content heads, you can move them in the
order you want them to appear in the list.
To remove any content heading, click the left arrow key.
9. Click Next to define the filters.
10. Select at least one filter which is a subset for the list. Use the arrow keys
to move the filter name to the Conditions applied column.
11. Optionally, choose size and ranking of the list.
You can have only the first twenty rows to see only information about
twenty customers each time you generate the list. You can also sort the
list by the content defined. Select ascending or descending from the Order
By drop-down list.
12. Click Generate to generate the list.
Note:

The list can take a while to generate as the system reads the entire
database based on the list specifications.
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Configuring a Membership, Migration
or Multi-set Same Time Events analytic
The Membership, Migration and Multi-set Same Time Events analytics in
Set Analysis study trends in set metrics, however they study different facets
of these trends. The configuration of these analytics is similar in many ways,
with the following differences:
• The Membership analytic works with a set that contains all members in
one or more sets.
• The Migration analytic works with one or more sets that show information
on cross set migrants, for example, joiners.
• The Multi-set Same Time Events analytic works with one or more sets
that track the multiple activities of joiners, leavers, and stayers.
1. In the analytic edit panel, select sets to list in this analytic.
2. In the "Navigation Options" section, to put a hyperlink on the set name
to an analytic on the Central Mangement Server, activate Use set name
as hyperlink to go to and click Browse to navigate to the analytic.
The hyperlink text window is populated with the hyperlink text in an
openAnalytic text string. You can edit this text string. For information on
openAnalytic, see the Linking from goal, universe query and metric-based
analytics section in the documentation.
3. To hide the trend chart, activate Do not display an automatic trend
when clicking on a chart component.
When this option is deactivated, you can select an item in the chart list,
and its metric trend chart appears. This option is useful if you want more
space in the list for columns.
4. To set a hyperlink on data points to an analytic on the Central Mangement
Server, expand the "DataPoint Navigation options" section, and activate
Use data point as hyperlink to go to and click Browse to navigate to
the analytic.
The hyperlink text window is populated with the hyperlink text in an
openAnalytic text string. You can edit this text string. For information on
openAnalytic, see the Linking from goal, universe query and metric-based
analytics section in the documentation.
5. In the "Display Mode" section, select a mode.
6. In the "Time Window" section, select a window from the drop-down list.
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Related Topics

• Choosing a set metric for the Metrics Overview, Membership, Migration or
Multi-Set Same Time Events analytic

Choosing a set metric for the Metrics
Overview, Membership, Migration or
Multi-Set Same Time Events analytic
Note:

If you are configuring a metrics overview analytic, you can also select metrics
without sets.
1. In the analytic edit panel, expand Choose the sets to list in this analytic.
2. Select the set you want to include:
• All available sets
• All sets in these subject areas
If you select this option, choose the subject areas from the pane on
the right.
•

These specific sets
If you select this option, choose sets by selecting them in the left pane
and adding them to the right pane.

3. If you selected These specific sets, add a prompt by clicking Add under
the "Selected Sets" list box.
Related Topics

• Configuring a Membership, Migration or Multi-set Same Time Events analytic

Membership
The Membership analytic, available with Set Analysis, finds trends for sets
and allows you to view a selected set for a specified period.
Set Members reside in the set as of the most recent set refresh. Set Stayers
have resided in the set through more than one refresh.
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For example, if the same customer purchases a case of premium wine during
the months of March and April, that customer is included in the Stayer and
Member counts of the Wine Collector set.
Related Topics

• What is a stayer?

Migration
The Migration analytic, available with Set Analysis, shows the movement of
members from one set to another in the form of a graph.
Note:

Use set-based metrics containing cross-set migrants for the Migration analytic.
See the Set Analyis documentation for more information on sets. For more
information on set metrics, see the Performance Manager documentation.

Multi-set Same Time Events
The Multi-set same time events analytic shows concurrent inflows and
outflows over time.
Note:

Use set-based metrics containing the cross set joiner or leaver cross sets.
For more information on sets, see the Set Analysis documentation. For more
information on set metrics, see the Performance Manager documentation.
Set Joiners reside in the set as of, but not prior to, the last refresh.
Related Topics

• What are multi-set metrics?
• What is a joiner?

What are multi-set metrics?
For a particular set, you can select multiple subsets or measures or
transformations to define multiple metrics. For a particular group, you can
define metrics for each set that belongs to the group.
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For a particular level of the tree list, you can refresh or purge all the metrics
under this level. You can use a view by measure, by set, by subset or by
group. Multi-set metrics enable you to track relationships between sets over
time.
Four types of multi-sets metrics are built into the product:
•

"Migrants"
Migrants are individuals who left a given tier to join another given tier.
Migrants in a given period from Set A to Set B are: Set A leavers of the
period that joined Set B in that same period.
Migrant metrics are applicable to temporal sets only. Also they are not
commutative which means that Migrants from A to B are different from
Migrants from B to A.

•

"Overlapping members"
Overlapping Members of Sets A and B are: Set A Members of the period
that are also Members of Set B in that same period.
Overlapping Members are applicable to temporal sets only. They are
commutative which means that Overlapping Members of A and B are
identical to Overlapping Members of B and A.

•

"Same time Joiners"
Same time joiners in a given period of Sets A and B are: Set A Joiners
of the period that joined Set B in that same period.
Same time joiners are applicable to temporal sets only. They are
commutative which means that Same time joiners of A and B are identical
to Same time joiners of B and A.

•

"Same time Leavers"
Same time leavers in a given period of Sets A and B are: Set A leavers
of the period that left Set B in that same period.
Same time leavers is applicable to temporal sets only. They are
commutative which means that Same time leavers of A and B are identical
to Same time leavers of B and A.

SAP BusinessObjects Set Analysis User Guide

41

4

4

Set analytics
Profiler

Profiler
The Profiler analytic, available in Set Analysis, analyzes the individual level
information at the membership and metric levels. Use Individual Profiler to
create sets to profile your customers in ways that answer your business
questions.
Individual customers can belong to more than one set, or interest group. For
example, individual customers can belong to a specific age group,
geographical location, or marital status.
Customers can be classified, analyzed and treated in different ways using
set techniques. You can create broad or specific sets to categorize your
customers in ways that are relevant to your business.

Configuring the Profiler analytic
Profiler analyzes the individual level information at the membership and
metric levels.
1. In the profiler edit panel, select the views that you want displayed in the
analytic.
To select or unselect all of the views under "Membership" or "Metrics",
activate or deactivate them at the root level.
2. Select the subjects that you want listed.
You can choose to view all subjects, or select from the list of available
subjects.
3. Enter the ID.
This ID corresponds to the column name in the set dimension table.
4. Click OK to save the configuration.
Related Topics

• What is a subject?
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Visual Data Counts analytic
The Visual Data Counts analytic, available in Set Analysis, counts dimension
objects in a set. You use this analytic to identify the set populations with
significant amounts of members on which you can create analysis scenarios.
Visual data counts help you with set sampling.
You can perform the following functions using visual data counts:
•
•
•

Navigate through the database using the predefined object trees to locate
the categories of data required to fill the current set.
Create your own object trees for data navigation.
View the:
• contents of the database categories in the detail windows. These detail
windows provide information about the content of the categories and
how they relate to other categories.
• components of a category.
• relationship between the upper and lower window categories as
indicated in the object tree.
• number of members currently in the set, shown in the application view
bar.

Using Set Analyzer fast counts in visual data counts

A fast count is an pre-calculated, aggregate action created in Set Analyzer
that summarizes segment counts. Fast counts speed the navigation of object
trees which, in turn, speeds the process of selecting items in a set. If fast
count is defined,the data retrieval is much faster because the data is already
computed and store in set tables.
For more information on creating fast counts and object trees, see the Set
Analyzer Administrator’s Guide. For information on using object trees, see
the Set Analyzer User's Guide.
Related Topics

• What is an object tree?
• What is a fast count?
• What is a sampling?
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Configuring the Visual Data Counts analytic
1. In the visual data counts edit mode, expand the "Specify Visual Data
Definition" section.
2. Select a set subject from the "Subject" dropdown list.
3. Select the source table from the "Source" dropdown list.
The object tree appears in a dimension hierarchy list.
4. Select one or more dimensions and add them to the visual data count by
clicking >.
You can also select dimensions by double-clicking them.
When you add an dimension to the list:
• If you select a measure, the "Added Field Condition" panel appears,
where you can assign a "Yes/No Condition".
Note:

This condition is optional and only available on dimensions that have
a fast count. The condition you set refines the list of counts. If you
want to see the counts for all of the dimension's items, deactivate the
Yes/No Condition and click OK.
When you add a dimension without a fast count, you cannot add a
field condition. Choose to view exact counts.
If the yes/no condition is the same for the measure, click Default to
avoid the necessity of creating the condition more than once.
•

If you select a metric, a panel appears in which you select the type of
count to place on the dimension. If there is a fast count assigned to
the metric, choose Estimates only. If you, however prefer an exact
count or do not have a fast count assigned to the metric, choose Exact
Counts.

5. Click Options to configure the following analytic options:
• Activate Always use Source if required if you do not want estimates
and prefer the source fact tables always queried.
• Activate Always use Estimates if available if you always want
available fast counts used.
• Activate Default Yes/No conditions to Yes.
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When you select a dimension for a data count, the dimension defaults
to no, and you select the members of the dimension that you want to
use in the visual data count. Activating the option saves you time if
you want to use all members for all visual data counts, or have the
assumption of yes, and select the members that should not appear.
6. In the "Display Mode" section, select a mode.

Analytic display modes
The display formats are:
•
•
•
•

SVG – Scalable Vector Graphics format. This format is less interactive
than the applet.
Applet – The Java Applet allows interactive editing of the analytic.
Flash – Macromedia Flash provides a more interactive interface, and a
zero footprint.
HTML – The HTML display allows you to provide accessibility for
508-compliant analytics.

The display modes for the analytics are shown in the following table.
Analytic

SVG

Applet

Flash

HTML

Alerts

DHTML
X

Bubble chart

X

Control chart

X

Curve fitting

X

Frequency histogram

X

Gauge

X

Goal

X

X

X

Goal subscriptions

X

Goal-based influencer detail

X
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Analytic

SVG

Applet

Flash

HTML

Individual list

X

Influencer detail

X

Influencer gains chart

X

Interactive metric trend

X

Key influencers

X

X

Lag plot

X

X

Map

X

Membership

X

Metric forecaster

X

X
X

Metric list

X

Metric tree

X

Metrics overview

X

X

Migration

X

X

Model gains chart

X

Multi-set same time events

X

X

Navigation list

X

Normal probability

X

Pareto

X

Pie chart

X

Profiler
Radar chart
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Analytic

SVG

Applet

Flash

HTML

Scorecard

DHTML
X

Smoothing

X

Strategy Map

X

Text

X

Variable profile box plot

X

Visual data counts

X

Web page

X
X

Set analytics in the Analytic Catalog
The Set Analytics samples are based on Web Intelligence queries are
organized in the following categories:
•

Membership Analysis analytics:
• Membership breakdown
• Membership change
• Membership status

•

Set Metrics analytics:
• Multi set scatter
• Percent of group total
• Percent of enterprise
• Set compare
• Set vs enterprise
• Set vs group average
• Set vs group total growth
• Set vs group turnover

•

Migration analytics:
• Migrants compare
• Migration by tier
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Membership breakdown
Membership Breakdown is a sample Set Analysis analytic in the Dashboard
Builder Analytic Catalog that shows how the number of members is
decomposed into joiners and stayers rates (positive bars) over time. They
can be compared to the leavers rate represented as negative bars.

Migrants compare
Migrants compare is a sample Set Analytic in the Dashboard Builder Analytic
Catalog that compares metrics based on migrants. The standard net flow
enables the comparison of metrics that are measured in different units. For
this analysis to run, migrants metrics must be defined.

Migration by tier
Migration by Tier is a sample Set Analyic in the Dashboard Builder Analytic
Catalog that is useful for seeing general migration trends toward high-tier or
low-tier sets. Migration by Tier is a tabular analysis which shows the number
of migrants between sets representing different tiers as well as the amount
of overall up-migration and down-migration.
For this analysis to run, the names of the sets must have an alpha-numeric
ordering that represents their relative positions (for example, Tier 1, Tier 2,
Tier) and migrants metrics must be defined.

Multi set scatter
Multi-set scatter is a sample Set Analytic scatter plot in the Dashboard Builder
Analytic Catalog that compares joiners, leavers and stayers rates with respect
to the current values of the metrics simultaneously, for example, cost and
revenue.
Multi-set scatter shows a snapshot of two or more subsets of a set. Two
metrics define the scatter-plot X-Y axes.
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Tip: You can easily page through different periods.
Use this analysis to compare simultaneously current values for differing
subsets with respect to two measures. For example, if you want to know
whether a trend in revenue/cost ratios has emerged among Joiners and
Leavers, you can plot Revenue vs. Cost for Joiners and Leavers and compare
their relative positions.

Percent of group total
Percent of total group is a sample Set analytic in the Dashboard Builder
Analytic Catalog that shows how much a set contributes to the total of a
group. It is appropriate for use with mutually exclusive sets.
Percent of total group compares two metrics that are measured in different
units. Applied to a set of mutually exclusive tiers that covers all the individuals,
with a Count metric (for example, Number of individuals) and a Revenue
metric, this analysis is a 80:20 rule chart over time.

Percent of enterprise
Percent of Enterprise is a sample Set analytic in the Dashboard Builder
Analytic Catalog that shows how much a set contributes to the enterprise
total. The formula for Percent of Enterprise is:
Set Metric / Enterprise Metric

Set compare
Set compare is a sample Set analytic in the Dashboard Builder Analytic
Catalog that is useful for comparing sets at a point in time. Set compare
distinguishes the sets that are above the average (blue flat line) from those
that are below.
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Set vs enterprise
Set vs Enterprise is a sample Set analytic in the Dashboard Builder Analytic
Catalog that is useful for benchmarking a set metric against the enterprise.
Percent of origin makes the two lines start at the same value (100%) in order
to facilitate the comparison.

Set vs group average
Set vs Group average is a sample Set analytic in the Dashboard Builder
Analytic Catalog that is useful for benchmarking a set raw value against the
average value of a group.
Group average is calculated by averaging the values of the sets within the
group.

Set vs group total growth
Set vs total growth is a sample Set analytic in the Dashboard Builder Analytic
Catalog that is useful for benchmarking a set raw value against the group
total growth.
Total Growth solves the scale issue of set raw value versus group total. It
makes the group total trend relative to the starting value of the set trend, so
that the group total growth always starts with the same value as the set trend.

Set vs group turnover
Set vs Group turnover is a sample Set analytic in the Dashboard Builder
Analytic Catalog that is useful for benchmarking the turnover of a set against
the turnover of a group.
Set vs Group turnover reveals the amount of change, or churn, that has
occurred in a membership. The period of analysis here corresponds to the
set refresh period.
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No metrics are required for this analysis to run.

Linking from goal, universe query and
metric-based analytics
Linking to multiple documents from an analytic
based on a goal, metric or universe query
You can create links to multiple documents from a goal or metric-based
analytic. This is particularly useful for analytic drill down.
1. How you access the options for linking analytics to other documents,
depends on whether you are creating a new analytic or editing an existing
analytic.
• If you are creating an analytic, do one of the following in InfoView:
• Go to Open > Dashboard Builder > Create New Analytic.
• Go to Document List > New > Analytic.
•

If you are editing an analytic, select the analytic, then click Edit.

2. Expand Navigation.
3. The next step depends on whether you want:
• If you want to link the title of the analytic to multiple documents, click
Multiple Links below "Use Legend/Title as hyperlink to go to".
• If you want to provide data point navigation, so that users can click a
metric result and then view a filtered document that shows other results
for that specific time period, click Multiple Links below "Use data
point as hyperlink to go to".
The Edit Navigation Link dialog box appears.
4. Click Add, then click Browse to select the document or, if you want to
link to a web page, type the URL into the text box.
5. You can add several links to documents here.
6. Click Update, then click OK.
The link to the multiple documents appears.
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For example:
Drill Down Group Level||openAnalytic.jsp?Document
Name=Drill+Down+Group+Level&RepositoryType=C&Reposito
ryName=Feature Examples&DocumentExt=rpt&DocumentId=AW
bJOJEYvvVMnbtXEQ2An0s&sContentType=OnDe
mand&mode=full||TotalSales.rpt||openAnalytic.jsp?Docu
mentName=TotalSales.rpt&RepositoryType=C&Repository
Name=Feature Samples&DocumentExt=rpt&DocumentId=AdLEd
dSQNTlDhMiLiHoD7II&sContentType=OnDe
mand&mode=full||Business Objects||http://www.busines
sobjects.com
In this example the multiple link is created to:
• Drill Down Group Level
• TotalSales report
• www.businessobjects.com
The syntax of the links is as follows:
name1||URL||name2||URL||name3||URL
7. To check the links, click OK.
The analytic appears.
8. Place your cursor on a data point or the title.
If the links are defined correctly, a popup menu appears with list of
destination documents.
9. Click the destination document of your choice.
Note:

When linking from goal and predictive analytics you must enter the link
manually.
Related Topics

• OpenAnalytic variables used in goal, metric and universe query analytics
• Using variables for dynamic links to documents
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Linking from a goal, metric or universe query-based
analytic to a document or analytic
Adding links to analytics allows end users navigate from an analytic to other
analytics or documents that provide information for further analysis.
You can include prompt parameters in links. Adding prompt parameters
means that the data displayed on the target analytic or document is
dynamically generated according to the values displayed on the first analytic.
1. How you access the options for linking analytics to other documents
depends on whether you are creating an analytic or editing an existing
analytic:
• If you are creating an analytic, do one of the following in InfoView:
• Go to Open > Dashboard Builder > Create New Analytic.
• Go to New > Analytic.
•

If you are editing an analytic, select the analytic, then click Edit.

2. Expand Navigation.
3. The next step depends on whether you want to link the title or data points
to a destination document:
• If you want to link the title of the analytic to multiple documents, click
Browse below "Use Legend/Title as hyperlink to go to".
• If you want to provide data point navigation, so that users can click a
metric result to view a filtered document that shows other results for
that specific time period, click the Browse below "Use data point as
hyperlink to go to".
The "Edit Navigation Link Menu" dialog box appears.
4. Click Add, then Browse to select the document or, if you want to link to
a web page, type the URL into the text box.
Note:

When linking from goal and predictive analytics you must enter the link
manually.
5. Click Update, then click OK.

SAP BusinessObjects Set Analysis User Guide

53

4

4

Set analytics
Linking from goal, universe query and metric-based analytics

The URL to the document appears in the URL box. The URL reads as
follows:
openAnalytic.jsp?DocumentName=<FILE_NAME>
&RepositoryType= C&RepositoryName=<REPOSITORY_NAME>
&DocumentExt=<EXTN>& DocumentId=<DOCID>
&sContentType=OnDemand&mode=full
6. To check the links, click OK.
The analytic appears.
7. Place your cursor on a data point or the title.
8. When your cursor turns into a hand sign, click the data point or title.
The destination document appears.
Related Topics

• OpenAnalytic variables used in goal, metric and universe query analytics
• Linking to multiple documents from an analytic based on a goal, metric or
universe query
• Using variables for dynamic links to documents
• Using variables for dynamic links to documents

Using variables for dynamic links to documents
You can include variables in the links to documents so that the destination
document is filtered by the values for a specific metric, dimension, goal or
set.
Related Topics

• OpenAnalytic variables used in goal, metric and universe query analytics

OpenAnalytic variables used in goal, metric and universe query
analytics
The following table gives a description of each variable you can use when
used in creating links between analytics.
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Note:

A universe query analytic where a prompt is defined can use all of the
OpenAnalytic variables.
Variable

Description

$METRIC_ID$

Metric ID

$METRIC_NAME$

Metric Name

$SUBJECT_ID$

Subject ID

$SUBJECT_NAME$

Subject name

$SET_ID$

Set ID

$SET_NAME$

Set Name

$SET2_ID$

2nd Set ID (when metric based on two sets)

$SET2_NAME$

2nd Set Name (when metric based on two sets)

$POPULATION_ID$

Population ID

$POPULATION_NAME$

Population Name

$DIM_ID$

Dimension ID

$DIM_NAME$

Dimension Name

$DIM2_ID$

2nd Dimension ID

$DIM2_NAME$

2nd Dimension Name

$GOAL_NAME$

Name of goal associated with analytics

$GOAL_ID$

ID of goal associated with analytics

$SLICE_CODE$

Value of the slice (code)

$SLICE_NAME$

Value of the slice (name)

$CONDITION_ID$

Class Id from the source universe
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Variable

Description

$MEASURE_NAME$

Measure Name

$MIN_SLICE$

First slice of the dimension used for x-axis (QOU)

$MAX_SLICE$

Last slice of the dimension used for x-axis (QOU)

$CURRENT_SLICE$

Current slice of the dimension used for x-axis
(QOU)

$BEGIN_DATE$

Begin Date of the displayed period

$END_DATE$

End Date of the displayed period

$CURRENT_DATE$

Current period (corresponds to a data point in a
trend)

$MAP_CODE$

Code for the current region displayed

$MAP_NAME$

Name of current region displayed

$MAP_LONGNAME$

Long name of current region displayed

$MODEL_ID$

Model ID

$INFLUENCER_ID$

Influencer ID

$INFLUENCER_NAME$

Influencer Name

OpenAnalytic variables for Goal variance and Pareto analytics
Pareto analytic

You can only use the $METRIC_ID$ variable to link from a Pareto analytic.
Goal variance analytics

You can use the following variables to link from Goal Variance analytics:
• $CONDITION_ ID$
• $CONDITION_ NAME$
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•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

$DIM_ID$
$DIM_ NAME$
$GOAL_ ID$
$MEASURE_ NAME$
$METRIC_ ID$
$METRIC_ NAME$
$POPULATION_ ID$
$POPULATION_ NAME$
$SET_ ID$
$SET_ NAME$
$SET2_ ID$
$SET2_ NAME$
$SLICE_ CODE$
$SLICE_ NAME$
$SUBJECT_ ID$
$SUBJECT_ NAME$
$USER$

Note:

A universe query analytic where a prompt is defined can use all of the
OpenAnalytic variables.
Related Topics

• OpenAnalytic variables used in goal, metric and universe query analytics

OpenAnalytic variables for Map analytics
This table shows which variables can be used to link from Map analytics that
use metrics or a universe query.
Note:

A universe query analytic where a prompt is defined can use all of the
OpenAnalytic variables.
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Map analytic using metrics

Map analytic using a universe query

Variable
Title link

Map item
link

Title link

Map item link

X

X

X

X

$METRIC_ NAME$ X

X

X

X

$SUBJECT_ ID$

X

X

X

X

$SUBJECT_
NAME$

X

X

X

X

$SET_ID$

X

X

X

X

$SET_ NAME$

X

X

X

X

$SET2_ID$

X

X

X

X

$SET2_ NAME$

X

X

X

X

$POPULATION_
ID$

X

X

X

X

$POPULATION_
NAME$

X

X

X

X

$DIM_ID$

X

X

X

X

$DIM_NAME$

X

X

X

X

$METRIC_ ID$

$GOAL_NAME$

X

$GOAL_ID$

X

$SLICE_CODE$

X

X

X

$SLICE_NAME$

X

X

X

X

X

$CONDITION_ ID$ X
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Map analytic using metrics

Map analytic using a universe query

Variable
Title link

Map item
link

Title link

Map item link

$CONDITION_
NAME$

X

X

X

X

$MEASURE_
NAME$

X

X

X

X

$BEGIN_DATE$

X

X

$END_DATE$

X

X

X

X

X

X

X

X

$MAP_CODE$
$MAP_NAME$

X

$MAP_ LONGNAME$
$USER$

X
X

X

X
X

X

Related Topics

• OpenAnalytic variables used in goal, metric and universe query analytics

OpenAnalytic variables for Metric List and Strategy Map analytics
This table shows which variables can be used to link from Metric Lists and
Strategy Maps analytics (only when based on goals, metrics or universe
queries).
Metric List

Strategy Map

Title link

Attached analytic

X

X

Variable

$METRIC_NAME$
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Metric List

Strategy Map

Title link

Attached analytic

$SUBJECT_ID$

X

X

$SUBJECT_ NAME$

X

X

$SET_ID$

X

X

$SET_NAME$

X

X

$SET2_ID$

X

X

$SET2_NAME$

X

X

$POPULATION_ ID$

X

X

$POPULATION_ NAME$

X

X

$DIM_ID$

X

X

$DIM_NAME$

X

X

$GOAL_NAME$

X

X

$SLICE_CODE$

X

X

$SLICE_NAME$

X

X

$CONDITION_ID$

X

X

$CONDITION_ NAME$

X

X

$MEASURE_ NAME$

X

X

$USER$

X

X

Variable

Note:

A universe query analytic where a prompt is defined can use all of the
OpenAnalytic variables.
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Related Topics

• OpenAnalytic variables used in goal, metric and universe query analytics

OpenAnalytic variables for Metric Tree and Metrics Overview analytics
This table shows which variables can be used to link from Metric Trees and
Metrics Overview analytics.
Note:

A universe query analytic where a prompt is defined can use all of the
OpenAnalytic variables.
Metric Tree
Variable

Metrics Overview

Attached Analyt- Set Name
ic
Link

Datapoint
Link

$METRIC_ID$

X

$METRIC_NAME$

X

X

$SUBJECT_ ID$

X

X

$SUBJECT_ NAME$

X

X

X

$SET_ID$

X

X

X

$SET_NAME$

X

X

X

$POPULATION _ID$

X

X

$POPULATION _NAME$

X

X

$DIM_ID$

X

X

$DIM_NAME$

X

X

$GOAL_NAME$

X

$GOAL_ID$

X

$SLICE_ CODE$

X

X
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Metric Tree
Variable

Metrics Overview

Attached Analyt- Set Name
ic
Link

Datapoint
Link

$SLICE_ NAME$

X

X

$CONDITION _ID$

X

X

$CONDITION _NAME$

X

X

$MEASURE _NAME$

X

X

$BEGIN_DATE$

X

$END_DATE$

X

$CURRENT _DATE$

X

$USER$

X

X

X

Related Topics

• OpenAnalytic variables used in goal, metric and universe query analytics

OpenAnalytic variables for most volatile metrics and Set Membership analytics
This table shows which variables can be used to link from most volatile
metrics and set membership analytics.
Most Volatile Metrics

Set Membership

Analytic Link

Datapoint

Datapoint

$METRIC_ID$

X

X

$METRIC_NAME$

X

X

$SUBJECT_ID$

X

X

X

$SUBJECT_NAME$

X

X

X

Variable
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Most Volatile Metrics

Set Membership

Analytic Link

Datapoint

Datapoint

$SET_ID$

X

X

X

$SET_NAME$

X

X

X

$SET2_ID$

X

X

$SET2_NAME$

X

X

$POPULATION_ID$

X

X

$POPULATION_NAME$

X

X

$DIM_ID$

X

X

$DIM_NAME$

X

X

$SLICE_CODE$

X

X

$SLICE_NAME$

X

X

$CONDITION_ID$

X

X

$CONDITION_NAME$

X

X

$MEASURE_NAME$

X

X

$BEGIN_DATE$

X

X

$END_DATE$

X

X

$CURRENT_DATE$

X

X

$USER$

X

X

Variable

X

Note:

A universe query analytic where a prompt is defined can use all of the
OpenAnalytic variables.
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Related Topics

• OpenAnalytic variables used in goal, metric and universe query analytics

OpenAnalytic variables for Key Influencers analytics
The following variables can be used to link from Key Influencers analytics:
•
•
•

$MODEL_ID$
$INFLUENCER_ID$
$INFLUENCER_NAME$

Note:

A universe query analytic where a prompt is defined can use all of the
OpenAnalytic variables.
Related Topics

• OpenAnalytic variables used in goal, metric and universe query analytics

OpenAnalytic variables for the Metric Forecaster analytic
The following variables can be used to link to Metric Forecaster analytic:
•
•
•

$METRIC_ ID$
$BEGIN_ DATE$
$END_ DATE$

OpenAnalytic variables for the Interactive Metric Trend analytic
This table shows the variables can be used to link from Interactive Metric
Trends based on goals, metrics or universe queries.
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Variable

Legend

Datapoint

$METRIC_ID$

X

X

$METRIC_NAME$

X

X

$SUBJECT_ ID$

X

X

$SUBJECT_ NAME$

X

X

$SET_ID$

X

X
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Variable

Legend

Datapoint

$SET_NAME$

X

X

$SET2_ID$

X

X

$SET2_NAME$

X

X

$POPULATION_ ID$

X

X

$POPULATION_ NAME$

X

X

$DIM_ID$

X

X

$DIM_ NAME$

X

X

$SLICE_ CODE$

X

X

$SLICE_ NAME$

X

X

$CONDITION_ ID$

X

X

$CONDITION_ NAME$

X

X

$MEASURE_ NAME$

X

X

$MIN_ SLICE$

X

X

$MAX_ SLICE$

X

X

$CURRENT_ SLICE$

X

$USER$

X

X

$BEGIN_DATE$

X

X

$CURRENT_DATE$
$END_DATE$

X
X

X
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Note:

A universe query analytic where a prompt is defined can use all of the
OpenAnalytic variables.
Related Topics

• OpenAnalytic variables used in goal, metric and universe query analytics

OpenAnalytic variables for a Migration analytic
The following variables can be used to link from a datapoint in the Migration
analytic for set analysis:
•
•
•
•
•

$SUBJECT_ID$
$SUBJECT_ NAME$
$SET_ID$
$SET_NAME$
$USER$

Note:

A universe query analytic where a prompt is defined can use all of the
OpenAnalytic variables.
Related Topics

• OpenAnalytic variables used in goal, metric and universe query analytics

OpenAnalytic variables for Gauge analytics
This table shows which variables can be used to link from Gauges.
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Variable

Metric

$METRIC_ ID$

X

$METRIC_ NAME$

X

$SUBJECT_ ID$

X

$SUBJECT_ NAME$

X

$SET_ID$

X

$SET_NAME$

X
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Variable

Metric

Universe query

$SET2_ID$

X

$SET2_NAME$

X

$POPULATION _ID$

X

$POPULATION _NAME$

X

$DIM_ID$

X

X

$DIM_NAME$

X

X

$DIM2_ID$

X

$DIM2_NAME$

X

$GOAL_NAME$

X

$GOAL_ID$

X

$SLICE_ CODE$

X

$SLICE_ NAME$

X

$CONDITION _ID$

X

$CONDITION _NAME$

X

$MEASURE _NAME$

X

X

X

$MIN_SLICE$

X

$MAX_SLICE$

X

$CURRENT _SLICE$

X

$BEGIN_DATE$

X

$END_DATE$

X

$CURRENT _DATE$

X
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Variable

Metric

$USER$

X

Universe query

OpenAnalytic variables for the Pie, Bubble and Radar Charts
The following table shows which variables can be used to link from the Pie,
Bubble and Radar charts:
Variable

Pie Chart

Bubble Chart

$METRIC_ ID$

X

X

$METRIC_ NAME$ X

X

Radar Chart

$GOAL_ ID$

X

$GOAL_ NAME$

X

$BEGIN_ DATE$

X

X

X

$END_ DATE$

X

X

X

$CURRENT_
DATE$

X

X

X

Note:

A universe query analytic where a prompt is defined can use all of the
OpenAnalytic variables.
Related Topics

• OpenAnalytic variables used in goal, metric and universe query analytics

OpenAnalytic variables for Data Exploration analytics
The following variables can be used to link from the Data Exploration
analytics, which include Lag Plot, Frequency Histogram, Normal Probability
Plot, Smoothing and Curve Fitting :
• $METRIC_ID$
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•
•
•
•

$METRIC_NAME$
$BEGIN_DATE$
$END_DATE$
$CURRENT_DATE$

Note:

A universe query analytic where a prompt is defined can use all of the
OpenAnalytic variables.
Related Topics

• OpenAnalytic variables used in goal, metric and universe query analytics

nbPrompts
nbPrompts is a parameter used in customized links between analytics and
documents stored on the Central Management Server in which prompts are
allowed, including analytics, Crystal Reports, Desktop Intelligence and Web
Intelligence documents. Using nbPrompts, you can fill the prompt(s) in the
target document with openAnalytic variables.

nbPrompts syntax in links from goal and metric-based analytics
The following are examples of nbPrompts syntax:
openanalytic.jsp?...&mode=full&nbPrompts=1
&[analytic_prompt_name]=$METRIC_NAME$
openanalytic.jsp?...&mode=full&nbPrompts=3
&[analytic_prompt1]=$METRIC_NAME$&[analytic_prompt2]=
$BEGIN_DATE$&[analytic_prompt3]=$END_DATE$
where openanalytic.jsp?...&mode=full is automatically included in
the address when you select the target document, and you add the remaining
text using the following syntax:
&nbPrompts=[#]&[analytic_prompt_name]=
$METRIC_NAME$
where you replace [#] with the number of prompts, and for each prompt you
add the string &[analytic_prompt_name]=$METRIC_NAME$, where
[analytic_prompt_name] is replaced with the name of the prompt in the
analytic or document.
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Using openDocument in dashboards and analytics
The openDocument.jsp uses the "opendoc" context to open objects from a
document or dashboard in InfoView.
Use the following syntax:
/OpenDocument/opendoc/
openDocument.jsp?iDocID=vscmMCXk
&sIDType=CUID&sType=null&sInstance=Last
where vscmMCXk is the ID of the dashboard.
Note:

Use relative instead of absolute links to documents in InfoView, in the case
where you plan to migrate servers.
To use openDocument to open a dashboard from a document or dashboard:
/OpenDocument/opendoc/openDocument.jsp?
iDocID=vscmMCXk&sIDType=CUID&sType=null
To use openDocument to open an analytic from a document or dashboard:
/OpenDocument/opendoc/openDocument.jsp?
iDocID=vscmMCXk&sIDType=CUID&sType=null
Example: sInstance in openDocument syntax

Use the parameter sInstance=Last with the OpenDocument function to
retrieve the last instance of a Web Intelligence or Desktop Intelligence
report. You must specify the fully-qualified URL of the target document for
the parameter to take effect.
Note:

sInstance=Last has no effect in the OpenAnalytic function.

URL reporting using openDocument
URL reporting using openDocument provides URL access to multiple
document types by passing a URL string to a BusinessObjects Enterprise
server. openDocument provides commands to control how reports are
generated and displayed.
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You can use openDocument in BusinessObjects Enterprise to create
cross-system links to and from the following document types:
•

.wid: Web Intelligence documents

•

.rep: Desktop Intelligence documents

•

.rpt: Crystal reports

•

.car: OLAP Intelligence reports

Structuring an openDocument URL
The next sections explain how to use the openDocument function, and how
to construct the URL.
An openDocument URL is generally structured as follows:
http://<servername>:<port>/OpenDocument/opendoc/<platform
Specific>?<parameter1>&<parameter2>&...&<parameterN>
The exact syntax of the <platformSpecific> parameter depends on your
implementation:
•

For Java implementations, use openDocument.jsp in place of the
<platformSpecific> parameter.

•

For .NET implementations, use opendocument.aspx in place of the
<platformSpecific> parameter.

The URL is constructed using the parameters listed in openDocument
parameter overview
Joining parameters

Join parameters with the ampersand (&). Do not place spaces around the
ampersand. For example: sType=wid&sDocName=Sales2003
The ampersand is always required between parameters.
Spaces and special characters in parameter values

Because some browsers cannot interpret spaces, the parameters of the link
cannot contain spaces or other special characters that require URL encoding.
To avoid the misinterpretation of special characters, you can define a
URLEncoded string in the source database to replace the special character
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with an escape sequence. This will allow the database to ignore the special
character and correctly interpret the parameter value. Note that certain
RDBMS have functions that allow you to replace one special character with
another.
By creating an escape sequence for the plus sign (+), you can instruct the
database to interpret the plus sign as a space. In this case, a document title
Sales Report for 2003 would be specified in the DocName parameter as:
&sDocName=Sales+Report+for+2003&
This syntax prevents the database from misinterpreting the spaces in the
title.
Trailing spaces in parameter values

Trim trailing spaces at the end of parameter values and prompt names. Do
not replace them with a plus sign (+). The viewer may not know whether to
interpret the plus sign (+) as part of the prompt name or as a space. For
example, if the prompt name displays:
Select a City:_
(where _ represents a space), enter the following text in the link:
lsSSelect+a+City:=Paris
where the spaces within the prompt name are replaced with the plus sign,
and the trailing space is trimmed off.
For details on prompt parameters of the link, refer to openDocument
parameter overview .
Capitalization

All of the openDocument parameters are case sensitive.
Link length limit

The encoded URL cannot exceed 2083 total characters.
Parameter values in links to sub-reports

You cannot pass parameter values to a sub-report of a target Crystal report.
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Using the lsS parameter with OLAP Intelligence reports
If the target document is an OLAP Intelligence report (.car) you can use the
IsS parameter to specify prompts. The parameters are passed in as a
URL-encoded string using the unique name of the parameter set up in the
OLAP Intelligence report.
Example: Opening a report to a specific page

If 23CAA3C1-8DBB-4CF3BA%2CB8%2CD7%2CF0%2C68%2CEF%2C9C%2C6F is the URL-encoded
unique name for the page parameter in the OLAP Intelligence report, you
would use the following URL to open the OLAP Intelligence report to page
2:
http://<servername>:<port>/OpenDocument/<platformSpecif
ic>?sType=car&sIDType=InfoObject&iDocID=440&lsS23CAA3C18DBB-4CF3-BA%2CB8%2CD7%2CF0%2C68%2CEF%2C9C%2C6F=2

Example: Opening a cube parameter

If 8401682C-9B1D-4850-8B%2C5E%2CD9%2C1F%2C20%2CF8%2C1%2C62
is the URL-encoded unique name for the cube parameter opening the
warehouse cube in the catalogue FoodMart 2000 on MSAS, you would use
the following URL to open this cube parameter:
http://<servername>:<port>/OpenDocument/<platformSpecif
ic>?sType=car&sIDType=InfoObject&lsS8401682C-9B1D-48508B%2C5E%2CD9%2C1F%2C20%2CF8%2C1%2C62=CATALOG%3DFood
Mart%202000,CUBE%3Dwarehouse&iDocID=616

Using the lsM parameter with OLAP Intelligence reports
If the target document is an OLAP Intelligence report (.car) you can use the
IsM parameter to specify prompts. The parameters are passed in as a
URL-encoded string using the unique name of the parameter set up in the
OLAP Intelligence report.
As was the case for the lsS parameter, lsM parameters are also passed in
as a URL-encoded string using the unique name of the parameter set up in
the OLAP Intelligence report.
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Example: Opening a report

http://<servername>:<port>/OpenDocument/<platformSpecif
ic>?sType=car&sIDType=InfoObject&lsMADC216EA-D9A5-42B5AE%2C21%2C84%2CA9%2CF9%2C6E%2C31%2C7=[%5BCus
tomers%5D.%5BCountry%5D.%26%5BMexico%5D],[%5BCus
tomers%5D.%5BCountry%5D.%26%5BCanada%5D]&iDocID=544
This is a memberset parameter opening up a report with Customers >
Country > Mexico and Customers > Country > Canada in the view.

openDocument parameter overview
This section provides a brief overview of openDocument and includes a list
of available parameters. Details about the available parameters, their specific
uses, and relevant examples are also provided.
Note:

The document containing the openDocument link is called the parent
document, and it resides on the parent system. The document to which the
link points is called the target document, and it resides on the target system.
Table 4-10: Platform Parameters
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Parameter

Description

iDocID

Document identifier.

sDocName

Document name.

sIDType

Crystal object type.

sKind

The file type of target Desktop Intelligence
document.
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Parameter

Description

sPath

The name of the folder and subfolder containing the target document.

sType

The file type of target document or report.

token

A valid logon token for the current CMS session.

Table 4-11: Input Parameters

Parameter

Description

lsC

Specifies a contextual prompt if there is an
ambiguity during SQL generation (Business
Objects and Web Intelligence documents only).

lsM[NAME]

Specifies multiple values for a prompt,
[NAME] is the text of the prompt

lsR[NAME]

Specifies a range of values for a prompt,
[NAME] is the text of the prompt.

lsS[NAME]

Specifies a value for a single prompt. [NAME]
is the text of the prompt.

sInstance

Indicates which specific instance of the target
report to open.
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Parameter

Description

sPartContext

In Crystal Reports, a report part is associated
to a data context.

sRefresh

Indicates whether a refresh should be forced
when the target document or report is opened.

sReportMode

For Crystal targets only, indicates whether
the link should open the full target report or
just the report part specified in sReportPart.

sReportName

Indicates which report to open if target document is multi-report.

sReportPart

Indicates which specific part of the target report to open.

Table 4-12: Output Parameters
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Parameter

Description

NAII

Forces the display of the prompt selection
page.

sOutputFormat

Indicates the format in which the target document is opened.

sViewer

Indicates the selected report viewer (CR &
CA only).
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Parameter

Description

sWindow

Indicates whether the target report will open
in the current browser window or whether a
new window will be launched.

openDocument platform parameters
This section details the openDocument platform parameters that are available
and gives examples on how to use the commands.
An openDocument URL is generally structured as follows:
http://<servername>:<port>/OpenDocument/opendoc/<platform
Specific>?<parameter1>&<parameter2>&...&<parameterN>
The exact syntax of the <platformSpecific> parameter depends on your
implementation:
•

For Java implementations, use openDocument.jsp in place of the
<platformSpecific> parameter.

•

For .NET implementations, use opendocument.aspx in place of the
<platformSpecific> parameter.

Note:

Variables are denoted with angle brackets. You must substitute the proper
value for these variables. For example, you must use the name of your server
in place of <servername> where it is contained in the code samples below,
and you must use your port number in place of <port>.

iDocID
Syntax

Description

Mandatory? Values

iDocID

Document identifier.

Yes*

Document identifier (InfoObjectID).
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Note:

*One of sDocName or iDocID is mandatory.
Example:

http://<servername>:<port>/OpenDocument/opendoc/<plat
formSpecific>?sType=wid&sDocName=SalesReport&iDocID=2010
Note:

To obtain the document ID, navigate to the document within the Central
Management Console (CMC). The properties page for the document
contains the document ID and the CUID. Use this value for the iDocID
parameter.

sDocName
Syntax

Description

Mandatory? Values

Document name without
extension
If multiple documents
Yes*
have the same name,
specify the correct document with iDocID.

sDocName

Document name.

Note:

*One of sDocName or iDocID is mandatory.
Example:

http://<servername>:<port>/OpenDocument/opendoc/<plat
formSpecific>?sPath=[Sales+Reports]&sDoc
Name=Sales+in+200
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sIDType
Syntax

Description

Mandatory? Values

Central Management
Server (CMS) object
identifier type.

sIDType

Yes*

•
•
•
•
•

CUID
GUID
RUID
ParentID
InfoObjectID (default)

Note:

*Only mandatory if the target is a Crystal report or OLAP Intelligence report
(sType=rpt or sType=car) in an Object Package. Otherwise, use sPath
and sDocName.
Example:

http://<servername>:<port>/OpenDocument/opendoc/<plat
formSpecific>?iDocID=2010&sIDType=CUID

sKind
Syntax

Description

Mandatory? Values

sKind

The file type of target
Desktop Intelligence doc- Yes*
ument.

•

FullClient

Note:

*Only mandatory if the target is a Desktop Intelligence document. Otherwise,
use sType.
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Example:

http://<servername>:<port>/OpenDocument/opendoc/<plat
formSpecific>?sKind=FullClient

sPath
Syntax

Description

Mandatory? Values

sPath

The name of the folder
and subfolder containing Yes*
the target document.

Folder and/or subfolder:
[folder],[subfold
er]

Note:

*Only mandatory if a value is specified for sDocName and is not unique.
sPath is used only with subfolders of the Public Folders folder. If your
document is outside of the Public Folders folder, for example in the My
Favorites folder, use the iDocID parameter instead of sPath and
sDocName.
Do not add [Public+Folders] to the path; start with the name of the first
subfolder within Public Folders.
Public Folders
folder 1
folder 1.1
folder 1.1.1
If your document were in folder 1.1.1, you would set sPath to: [fold
er+1],[folder+1.1],[folder+1.1.1].
Example:

http://<servername>:<port>/OpenDocument/opendoc/<plat
formSpecific>?sPath=[Sales+Reports]&sDoc
Name=Sales+in+2005
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sType
Syntax

Description

Mandatory? Values

The file type of target
document or report.

sType

Yes

•

wid

•

rpt

•

car

Note:

This parameter is ignored for agnostic documents.
Example:

http://<servername>:<port>/OpenDocument/opendoc/<plat
formSpecific>?sType=wid

token
Syntax

Description

Mandatory? Values

token

A valid logon token for
No
the current CMS session.

The logon token for the
current CMS session.

Example:

http://<servername>:<port>/OpenDocument/opendoc/<plat
formSpecific>?sType=wid&sDocName=Sales+in+2003&token=<lo
gonToken>

openDocument input parameters
This section details the openDocument input parameters that are available
and gives examples on how to use the commands.
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An openDocument URL is generally structured as follows:
http://<servername>:<port>/OpenDocument/opendoc/<platform
Specific>?<parameter1>&<parameter2>&...&<parameterN>
The exact syntax of the <platformSpecific> parameter depends on your
implementation:
•

For Java implementations, use openDocument.jsp in place of the
<platformSpecific> parameter.

•

For .NET implementations, use opendocument.aspx in place of the
<platformSpecific> parameter.

Note:

Variables are denoted with angle brackets. You must substitute the proper
value for these variables. For example, you must use the name of your server
in place of <servername> where it is contained in the code samples below,
and you must use your port number in place of <port>.

lsC
Syntax

lsC

Description

Specifies a contextual
prompt if there is an ambiguity during SQL generation (Business Objects
and Web Intelligence
No
documents only).
Note:

Not supported by OLAP
Intelligence
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Example:

http://<servername>:<port>/OpenDocument/opendoc/<plat
formSpecific>?sType=wid&sDocName=SalesReport&iDo
cID=2010&lsC=Sales

lsM[NAME]
Syntax

Description

Mandatory? Values

•

Multiple prompt values, separated by a
comma. If the target is
a Crystal report, each
value must be enclosed in square
brackets. If the target
is a OLAP Intelligence
report, use the MDX
WITH clause.

•

no_value (only for
optional parameters)

Specifies multiple values
for a prompt. [NAME] is No
the text of the prompt.

lsM[NAME]

Note:

•

•

•

You can remove an optional parameter from the prompt by setting it to
no_value in the openDocument query string. If you leave an optional
parameter out of the openDocument query string, a default parameter
value will be applied.
The character ? is a reserved prompt value for Web Intelligence
documents in an openDocument URL. Setting the prompt value to
lsM[NAME]=? in the URL forces the "Prompts" dialog box to appear for
that particular prompt.
For information on using this parameter with OLAP reports, see Using
the lsM parameter with OLAP Intelligence reports .
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Example:

http://<servername>:<port>/OpenDocument/opendoc/<plat
formSpecific>?sType=rpt&sDocName=SalesReport&lsMSe
lect+Cities=[Paris],[London]

lsR[NAME]
Syntax

Description

Mandatory? Values

•

A range of values for
the prompt, separated
by a double period (..).
If the target is a Crystal report, the range
must be enclosed in
square brackets
and/or parentheses
(use a square bracket
next to a value to include it in the range,
and parentheses to
exclude it).

•

no_value (only for
optional parameters)

Specifies a range of values for a prompt. [NAME]
is the text of the prompt.
lsR[NAME]

Note:

No

Not supported by OLAP
Intelligence

Note:

You can remove an optional parameter from the prompt by setting it to
no_value in the openDocument query string. If you leave an optional
parameter out of the openDocument query string, a default parameter value
will be applied.
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Example:

http://<servername>:<port>/OpenDocument/opendoc/<plat
formSpecific>?sType=rpt&sDocName=SalesReport&lsRTime+Pe
riod:=[2000..2004)

lsS[NAME]
Syntax

Description

Mandatory? Values

lsS[NAME]

Specifies a value for a
single prompt. [NAME] is No
the text of the prompt.

•

A single prompt value.

•

no_value (only for
optional parameters)

Note:

•

•

•

You can remove an optional parameter from the prompt by setting it to
no_value in the openDocument query string. If you leave an optional
parameter out of the openDocument query string, a default parameter
value will be applied.
The character ? is a reserved prompt value for Web Intelligence
documents in an openDocument URL. Setting the prompt value to
lsS[NAME]=? in the URL forces the "Prompts" dialog box to appear for
that particular prompt.
For information on using this parameter with OLAP reports, see Using
the lsS parameter with OLAP Intelligence reports.

Example:

http://<servername>:<port>/OpenDocument/opendoc/<plat
formSpecific>?sType=wid&sDocName=SalesReport&iDo
cID=2010&lsSSelect+a+City=Paris
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sInstance
Syntax

Description

Mandatory? Values

Indicates which specific
instance of the target re- No
port to open.

sInstance

•

User (Link to latest
instance owned by
current user)

•

Last (Link to latest
instance for report)

•

Param (Link to latest
instance of report with
matching parameter
values)

Note:

Use this parameter in combination with sDocName.
Example:

http://<servername>:<port>/OpenDocument/opendoc/<plat
formSpecific>?sPath=[Sales+Reports]&sDoc
Name=Sales+in+2003&sReportPart=Part1&sInstance=User

sPartContext
Syntax

Description

Mandatory? Values

sPartContext

In Crystal Reports, a report part is associated to Yes*
a data context.

Data context of the report
part.

Note:

*Only mandatory if a value is specified for sReportPart.
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Example:

http://<servername>:<port>/OpenDocument/opendoc/<plat
formSpecific>?sPath=[Sales+Reports]&sDoc
Name=Sales+in+2005&sReportPart=Part1&sPartContext=0-40
Note:

The sReportPart and sPartContext parameters are supported with the
regular DHML viewer (sViewer=html). Instead of the first page of the report,
the DHTML viewer displays the page and context containing the part with
the part highlighted.

sRefresh
Syntax

Description

Mandatory? Values

sRefresh

Indicates whether a refresh should be forced
No
when the target document or report is opened.

•

Y (forces the document’s refresh)

•

N (note that the refresh on open feature
overrides this value)

Example:

http://<servername>:<port>/OpenDocument/opendoc/<plat
formSpecific>?sType=wid&sDocName=SalesReport&iDo
cID=2010&sRefresh=Y
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sReportMode
Syntax

Description

Mandatory? Values

sReportMode

For Crystal targets only,
indicates whether the link
should open the full tarNo
get report or just the report part specified in
sReportPart.

•

Full

•

Part

Note:

Defaults to Full if this parameter is not specified. Only applies if a value is
specified for sReportPart.
Example:

http://<servername>:<port>/OpenDocument/opendoc/<plat
formSpecific>?sPath=[Sales+Reports]&sDoc
Name=Sales+in+2003&sReportPart=Part1&sReportMode=Part

sReportName
Syntax

Description

Mandatory? Values

sReportName

Indicates which report to
open if target document No
is multi-report.

Report name for Web Intelligence documents,
sub-report for Crystal Reports, pages for OLAP
Intelligence reports.

Note:

Defaults to the first report if this parameter is not specified.
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Example:

http://<servername>:<port>/OpenDocument/opendoc/<plat
formSpecific>?sType=wid&sDocName=Sales+in+2003&sReport
Name=First+Report+Tab

sReportPart
Syntax

Description

Mandatory? Values

sReportPart

Indicates which specific
part of the target report to No
open.

Name of the report part.

Example:

http://<servername>:<port>/OpenDocument/opendoc/<plat
formSpecific>?sPath=[Sales+Reports]&sDoc
Name=Sales+in+2003&sReportPart=Part1
Note:

The sReportPart and sPartContext parameters are supported with the
regular DHML viewer (sViewer=html). Instead of the first page of the report,
the DHTML viewer displays the page and context containing the part with
the part highlighted.

openDocument output parameters
This section details the openDocument output parameters that are available
and gives examples on how to use the commands.
An openDocument URL is generally structured as follows:
http://<servername>:<port>/OpenDocument/opendoc/<platform
Specific>?<parameter1>&<parameter2>&...&<parameterN>
The exact syntax of the <platformSpecific> parameter depends on your
implementation:
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•

For Java implementations, use openDocument.jsp in place of the
<platformSpecific> parameter.

•

For .NET implementations, use opendocument.aspx in place of the
<platformSpecific> parameter.

Note:

Variables are denoted with angle brackets. You must substitute the proper
value for these variables. For example, you must use the name of your server
in place of <servername> where it is contained in the code samples below,
and you must use your port number in place of <port>.

NAII
Syntax

Description

Mandatory? Values
•

Forces the display of the
prompt selection page.
Note:

NAII

Only supported by Web
Intelligence documents.

No

Y (prompt values that
are passed with lsS,
lsM, or lsR in the
URL are applied and
not displayed in the
"Prompts" dialog box)

Note:

•

•

NAII=Y raises the "Prompts" dialog box for any values not specified in
the URL. Prompts created with default values are still displayed in the
"Prompts" dialog box.
If all prompt values are specified in the URL, the prompt window does
not appear even if NAII=Y is specified.

Example:

This example assumes there are two prompts in the Web Intelligence
document: Year and Country. NAII=Y forces the "Prompts" dialog box
to appear and allows the user to specify a value for the Country prompt.
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The Year prompt is already set to a value of FY1999 in the URL using the
lsS parameter and therefore is not prompted for.
http://<servername>:<port>/OpenDocument/opendoc/<plat
formSpecific>?sType=wid&sDocName=SalesReport&iDo
cID=2010&lsSYear=FY1999&NAII=Y&sRefresh=Y

sOutputFormat
Syntax

Description

Mandatory? Values

sOutputFormat

Indicates the format in
which the target document is opened.

No

•
•
•
•

H (HTML)
P (PDF)
E (Excel)
W (Word)

Note:

Defaults to HTML if this parameter is not specified.
Example:

http://<servername>:<port>/OpenDocument/opendoc/<plat
formSpecific>?sPath=[Sales+Reports]&sDoc
Name=Sales+in+2003&sOutputFormat=E

SAP BusinessObjects Set Analysis User Guide

91

4

4

Set analytics
Linking from goal, universe query and metric-based analytics

sViewer
Syntax

Description

Mandatory? Values

•
•
sViewer

Indicates the viewer that
is used to view the docu- No
ment.

•
•

html
part (Crystal reports
only)
actx (Crystal reports
only)
java (Crystal reports
only)

Example:

http://<servername>:<port>/OpenDocument/opendoc/<plat
formSpecific>?sPath=[Sales+Reports]&sDoc
Name=Sales+in+2003&sViewer=html

Example:
Note:
In order to use parameters in the URL with the ActiveX viewer, :connect
must be appended to the URL, followed by the parameters.

http://<servername>:<port>/OpenDocument/opendoc/<plat
formSpecific>?sPath=[Sales+Reports]&sDoc
Name=Sales+in+2003&sViewer=actx:connect&IsMCountry=[Thai
land],[Norway]
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sWindow
Syntax

Description

Mandatory? Values

sWindow

Indicates whether the
target report will open in
the current browser win- No
dow or whether a new
window will be launched.

•

Same (current browser
window)

•

New (new browser
window is launched)

Example:

http://<servername>:<port>/OpenDocument/opendoc/<plat
formSpecific>?sType=wid&sDocName=SalesReport&iDo
cID=2010&sWindow=New

Contextual report linking
The openDocument feature allows you to create contextual links between
Crystal reports, OLAP Intelligence reports and Web Intelligence documents.
To do this, you construct a URL using the openDocument syntax and then
insert the URL into a Crystal report, OLAP Intelligence report or Web
Intelligence document.
Contextual report linking allows report designers to specify associations for
documents residing in either a Crystal Reports environment (unmanaged)
or a BusinessObjects Enterprise environment (managed). Once these
associations are created, users follow the resulting navigational paths
embedded in the linked documents.
This feature enables you to invoke Business Objects and Web Intelligence
documents from Crystal Reports and vice versa. This feature relies on
functionality that allows the user to do the following:
•

Link Web Intelligence or Business Objects documents within the document
domain.

•

Link report objects in Crystal Reports.
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To insert a link into a Crystal report
You can use openDocument to create hyperlinks in Crystal Reports. To
create a link to another report or document, use the Hyperlink Tab of the
field Format Editor.
1. Open the source report in Crystal Reports.
2. Right-click the field in which you want to insert the openDocument link
and select Format from the shortcut menu.
3. In the Format Editor, select the Hyperlink tab.
4. Select A website on the Internet.
5. In the “Hyperlink information ? area, leave the Website Address field
empty and click the Format Formula Editor button.
6. Enter the openDocument link in the following format:
"http://[openDocument parameters]"+{Article_lookup.Fam
ily_name}
Where [openDocument parameters] are described in openDocument
parameter overview , and the {Article_lookup.Family_name} enables the
report to pass context-dependent data.
Note:

Test your link in a browser window before inserting it into a report or
document.
7. Click Save and Close to leave the Formula Workshop.
8. Click OK in the Formula Editor to save the link.

To create a link to another report or document from an OLAP Intelligence
report
You can use openDocument to create hyperlinks in OLAP Intelligence reports.
1.
2.
3.
4.
5.
6.
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Open the source report in the OLAP Intelligence designer.
On the Tools menu, select Action Manager .
Click New to create a new action.
Enter an action name.
Select the area to which the action (the link) will apply.
Enter the openDocument link using the parameters and syntax described
in this document.
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Tip:

Test your link in a browser window before inserting it into a report or
document.
7.
8.
9.
10.
11.
12.
13.

Click OK to save the link.
Close the Action Manager dialog box.
Create an Analysis Button on the source report.
Right-click the Analysis Button.
In the drop-down menu, select Properties and then Edit .
Select Launch an action .
Select the action that corresponds to the openDocument link created in
steps 3 through 6.
14. Click OK .

Creating links in Web Intelligence documents
You can define objects in a universe that allow Web Intelligence and
BusinessObjects users to create reports whose returned values include links
to other reports and documents.
When these reports are exported to the repository, users can click returned
values displayed as hyperlinks to open another related document stored in
the document domain of the repository.You create these links using the
openDocument function in the definition of an object in Designer.
More information

For full information on creating links in Web Intelligence reports, see the
Building Reports Using the WebIntelligence Java Report Panel guide.
You enable report linking in a universe by creating an object (the link object)
whose returned values are the same as the values used as input to a prompt
in an existing report (the target report).
The openDocument function allows the values for the link object to be
returned as hyperlinks. When the user clicks the hyperlink, its value is used
as the prompt input for the target report.
You can create documents using the link object as you would with any other
object. Users can then click the hyperlinks to access more detailed documents
related to the link object.
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To create a link object, use the openDocument function in the object’s Select
statement. The Select statement for a link object follows this order:
'<a href="http://<servername>:<port>/OpenDocument/<plat
formSpecific>?sDocName=<document name>&sType=<document
type>&iDocID=<document id>&lsS<prompt message>='+object
SELECT+'">'+object SELECT+'</a>'
The concatenation operator (+) applies for Microsoft Access databases. Use
the operator appropriate to your target RDBMS.
For more details on the Select statement, creating link objects, and using
link objects in InfoView, refer to the Designer’s Guide.

Sending information to the Viewer analytic in a
dashboard using openAnalytic
Using the openAnalytic syntax, you can send information from the following
documents saved on the Central Management Server (CMS) to a Viewer
analytic on a dashboard:
• Web Intelligence reports
• Crystal Reports
• Text analytic
• Desktop Intelligence reports
• Web page analytic
Sample syntax:
<a href='http://[WEB APPLICATION LOCATION]
aa-open-inlist.jsp?url=openAnalytic.jsp?
DocumentName=text+analytic&RepositoryType=C
&RepositoryName=PM&DocumentExt=afd
&DocumentId=AQ74dXHxW59HlHvZivNsypI&mode=full
' target='hiddenFrame'>[LINK NAME IN DASHBOARD]</a>
The key items in the sample are aa-open-inlist.jsp and target='hid
denframe'.
1. In a text editor, copy and paste the sample syntax.
2. Replace [WEB APPLICATION LOCATION] with the web application
location after http://.
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For example: http://<server>:<port>/PerformanceManage
ment/jsp
3. Enter the correct information after the variables.
4. Replace [LINK NAME IN DASHBOARD] with the name of the link as you
want it to appear.
5. Copy and paste the text in the following location:
• For a Web Intelligence, Crystal Report or Desktop Intelligence report,
copy the text in the cell of the query and then run a report.
• For a Text analytic, go to the edit mode and paste the text in the "Enter
text or HTML to display" text box and select html. Save the analytic
in the public folders.
• For a Web page analytic, go to the edit mode and in the "Content" tab
paste the text in the "Enter the web page URL" text box and click OK.
In the "Layout" tab, select from the "Display as" section A link, so
only the name is visible.
6. In InfoView, go to Dashboards > Create Corporate Dashboard.
7. Enter the title, select a public folder, and click OK.
8. Click Dashboards > Organize Corporate Dashboards, and select your
dashboard.
9. Click Edit Dashboard.
10. From the "Analytic Toolbox", expand the "Corporate Analytics" list to find
your report, and drag it to the dashboard layout.
11. From the "Analytic Toolbox", expand the "New Analytic" list, and drag the
"Viewer" analytic from the list to the dashboard layout.
12. Click Save, then Exit Edit Mode.
Click on any linked item in the report and the destination appears in the
viewer.

Individual Set Analysis analytics
Individual analysis delivers detailed historical information describing the
evolution of an individual's relationship to the business. It can be used to
profile customers, products and partners. Individual analysis supports
discovery of pattern that occurs over a period of time, which can lead to new
ideas for segmentation. It delivers not only individual-level attribute data, but
also the information needed to understand relationship history.
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For example, high value customer profiling can uncover patterns that foretell
high value behavior within a set. An individual behavior can be a benchmark
to a wider population within the set.
The "Individual" tab in Set Analysis shows samples of analytics that analyze
the behavior of the selected individual in relation with one or more sets:
•
•
•

Profiler
Individual portrait
Membership
• Current membership
• Membership history
• Membership summary

•

Sample metrics analytics for set analysis
• Metric trends
• Metrics summary
• Set vs individual

Profiler
The Profiler analytic, available in Set Analysis, analyzes the individual level
information at the membership and metric levels. Use Individual Profiler to
create sets to profile your customers in ways that answer your business
questions.
Individual customers can belong to more than one set, or interest group. For
example, individual customers can belong to a specific age group,
geographical location, or marital status.
Customers can be classified, analyzed and treated in different ways using
set techniques. You can create broad or specific sets to categorize your
customers in ways that are relevant to your business.

Individual portrait
Individual portrait is an Individual Set Analysis analytic that displays
descriptive information on a selected individual. Reports and documents that
provide additional details such as transaction history can be linked if they
have been set up during configuration.
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This analytic provides an interface to two kinds of information:
•
•

Standard Dimension or Attribute Information
Detail information, such as transaction histories or other contact

Note:

The fields displayed are dependent on the access granted to your profile by
the system administrator.

Current membership
Current membership is a Individual Set Analysis analytic that displays the
summary information of an individual set membership at a point in time. The
point in time defaults to Today, or to the End Date for the selected time
window if the Point Summary is visited after you visit a Period view (Summary
or History).
Current membership helps you better interpret the information in the Summary
View (for example, determining whether the Period information is consistent
with historical behavior or indicative of a change).

Membership history
Membership history is an Individual Set Analysis analytic that displays the
details of a membership history for a selected individual. Each row displays
the episodes of membership for the selected individual within the selected
time interval. Each line set represents a single episode of membership. The
minimum length of any episode displayed for a given set is determined by
its refresh frequency.
The time window ruler enables selection of a time window within which the
history is displayed. The grain of the ruler determines whether the time ruler
cursors work in days, weeks, months, quarters or years. Zoom buttons widen
and reduce the date range displayed in the ruler. Varying the width of the
time window can change the episode display; wider intervals widen the grain
of the display.
If the interval between adjacent episodes is too short to display adequately
due to the scale of the window width, then the character used to display the
line is changed to signify the missing detail.
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Sets are selectable via the standard tree list operation.
Membership history provides information about individual membership history
over a period of time. Broken lines indicate that the individual has moved
within a set.

Membership summary
Membership summary is an Individual Set Analysis analytic that displays the
membership summary for an individual across time windows. This analytic
similar to the Current Membership analytic, except that the time ruler is used
to select an interval instead of a single date. The columns are also similarly
defined but are restricted to the selected time window on the ruler.
Select the set to see membership episodes dates within the selected time
window.
The following information is displayed:
•
•
•
•

Presence: the total number of days present in the set since the first day
of joining
# Occurrence: total number of times the individual left and came back
into the set in the selected time period
Avg Duration: the average duration for which the individual was part of
the set
Presence %: percentage value of the present days in the set

Related Topics

• Current membership

Sample metrics analytics for set analysis
You can use the following "Individual Set" analytics to provide a powerful
facility for observing the evolution of an individual with respect to one or more
metrics over time:
•
•
•
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To facilitate meaningful interpretation of individual data, the "Summary" and
"Trend" sub tabs support comparison of individual data with one or more
metrics.
Grain selection in the "Metric" tab is based on the metric selected first.

Metrics summary
Metrics Summary analytic on the Set AnalysisIndividual tab displays the
summary view of an individual's metric values. This analytic presents measure
values for the individual based on a selected period as well as the
closest-in-time metric values.
In Metric Summary, the calculation interval for the individual is the same as
the Observation Time Interval.
The most recent refresh date for the metric value is displayed, as well as the
metric value. The format of the date reveals the metric grain. To ensure that
the individual's values are directly comparable to the metric values, select a
grain and double click the Time Ruler to select a single period of that grain.
Values of the selected metric of that grain are displayed in normal font.
Otherwise, the values are shown in gray and the following criteria are used
to select the best matching metric value:
•
•
•

Which is the most recent, entirely contained sub-interval of the selected
period?
Which has the larger period (with data) that includes the greatest portion
of the selected period?
Which has the smaller period among the one or more smaller periods
touching the selected interval that is the most recent (with data)?

A metric value is displayed in regular font if the selected time interval
corresponds to the period for the metric and a value exists for it. Metric
periods are single day, week, month, quarter or year.

Metric trends
Metric Trends analytic on the Set AnalysisIndividual tab is a sample of a
Metric Trends analytic that displays the time series trend of metrics for a
selected individual for a set time period. This analytic displays trends for
Business Objects measures calculated for a selected individual over the
selected time interval. These trends are for the selected individual metrics.
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You can also select sets and see the trend of the individual with one or more
sets.
When configuring Metric Trends, choose the metrics to display by selecting
the set from the set tree list and the metric/transformation combinations from
those that are available.
You can first choose which metrics to display and then, in a subsequent step,
set the calculation, and display of the individual's values for the selected
metric.

Set vs individual
Set vs. Individual is a sample Individual Set Analysis analytic that compares
a metric trend line for an individual to that of one or more sets. This analytic
allows you to compare a metric trend line for an individual to that of one or
more sets. Values can be compared directly or trends can be compared
using percentage change from origin.
Set vs. Individual helps you benchmark an individual to set averages over
time, or alternatively, as might be useful in a B2B scenario, how much of set
totals are accounted for by the selected individual.
Note:

Use % change from origin when comparing trends lines for sums or counts,
when an average by individual metric is not available. Alternatively, view the
raw values to analyze trends with respect to proportion of total metric value
accounted for by the selected individual.

Set Analysis Terms
What is a broken stayer?
In the analysis of sets, a broken stayer is an individual who was present in
a set at the end of the period of analysis and was present just before this
period but who left within the period of analysis.
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What is a continuous stayer?
In the analysis of sets, a continuous stayer is an individual who was present
in a set at the end of the period of analysis and was present just before this
period and who did not leave within the period of analysis.

What is a fast count?
A Set Analyzer Administrator creates fast counts in Set Architect. A fast count
is an precalculated, aggregate action created in Set Analyzer that summarizes
segment counts. Fast counts speed the navigation of object trees which, in
turn, speeds the process of selecting items in a set.
The Set Analyzer Administrator can also schedule fast counts in Set Architect
to occur at specified periods for better network performance. For more
information on creating fast counts and object trees, see the Set Analyzer
Administrator’s Guide. For information on using object trees, see the Set
Analyzer User's Guide.
Related Topics

• What is an object tree?

What is a joiner?
In the analysis of sets, a joiner is an individual who was present in a set in
a given period but was not present in the prior period. The period of analysis
here corresponds to the set refresh period. No metrics are required for this
analysis to run.

What is a leaver?
A leaver is an individual who was not present in a set in a given period but
was present in the prior period.
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What is migration?
In Set Analysis, migration is movement of individual customers from one set
to another.

What is an object tree?
In set analysis, object trees visualize data in the source database that users
can use to drill down through to locate items to include in a set.
A Set Analyzer Administrator creates object trees in Set Analyzer after
configuring the set repository with the appropriate metadata. It is normal to
create at least one object tree. Set Analyzer users can then use these object
trees to define the contents of their sets in the Set Analyzer VisualData view.
Set Analyzer users can also create their own custom object trees. The rows
in the source tables have relationships, inherent in the data, that point to
values that can be used for categorization. These values are seldom unique
and are common to many records or rows in the table. These values can be
used to group data together and are often related to other values in other
columns in a hierarchical way.
A table can have many inherent hierarchies that indicate how these columns
are related. Defining these hierarchies as object trees is a useful method of
providing access to the table items to the Set Analyzer user who is not familiar
with the structure of the data. In Set Analyzer, the object trees do not have
to relate to a logical hierarchy, but can be constructed from any combination
of suitable objects in the set repository.

What is retention?
In the analysis of sets, retention is the number of stayers as a percentage
of the members at the end of the prior period.
Related Topics

• What is a stayer?
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What is a sampling?
A sampling is a group of the population with specified information. Ideally
you want to analyze a large sample frequently to get the most accurate
estimates and the most up-to-date information.
In Process Analysis, larger samples make it easier to detect small shifts and
make the control chart more sensitive in detecting changes without increasing
the rate of false alarms.
Note:

Start the sampling when data is available. If no data exists, the sampling can
take longer than necessary to generate.

What is segmentation?
In Set Analysis, segmentation is a way of partitioning a group of individuals,
for example customers, prospects, or suppliers, into categories referred to
as sets. Usually the groups are mutually exclusive, but they can overlap.

What is a stayer?
In the analysis of sets, a stayer is an individual who is present in a set in a
given period as well as the prior period.

What is a subject?
In Set Analysis, the subject defines the central theme for the sets which are
based on it. A set can contain data for only one subject; for example,
customers, accounts, products, etc. In the context of a customer subject,
you can define sets that include conditions based on the various tables and
views that describe the customer entity.
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What is turnover?
In the analysis of sets, turnover is the number of leavers as a percentage of
the members at the end of the prior period.
Related Topics

• What is a leaver?
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What is a broken stayer?

What is a broken stayer?
In the analysis of sets, a broken stayer is an individual who was present in
a set at the end of the period of analysis and was present just before this
period but who left within the period of analysis.

What is a continuous stayer?
In the analysis of sets, a continuous stayer is an individual who was present
in a set at the end of the period of analysis and was present just before this
period and who did not leave within the period of analysis.

What is a fast count?
A Set Analyzer Administrator creates fast counts in Set Architect. A fast count
is an precalculated, aggregate action created in Set Analyzer that summarizes
segment counts. Fast counts speed the navigation of object trees which, in
turn, speeds the process of selecting items in a set.
The Set Analyzer Administrator can also schedule fast counts in Set Architect
to occur at specified periods for better network performance. For more
information on creating fast counts and object trees, see the Set Analyzer
Administrator’s Guide. For information on using object trees, see the Set
Analyzer User's Guide.
Related Topics

• What is an object tree?

What is a joiner?
In the analysis of sets, a joiner is an individual who was present in a set in
a given period but was not present in the prior period. The period of analysis
here corresponds to the set refresh period. No metrics are required for this
analysis to run.
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What is a leaver?
A leaver is an individual who was not present in a set in a given period but
was present in the prior period.

What is migration?
In Set Analysis, migration is movement of individual customers from one set
to another.

What is an object tree?
In set analysis, object trees visualize data in the source database that users
can use to drill down through to locate items to include in a set.
A Set Analyzer Administrator creates object trees in Set Analyzer after
configuring the set repository with the appropriate metadata. It is normal to
create at least one object tree. Set Analyzer users can then use these object
trees to define the contents of their sets in the Set Analyzer VisualData view.
Set Analyzer users can also create their own custom object trees. The rows
in the source tables have relationships, inherent in the data, that point to
values that can be used for categorization. These values are seldom unique
and are common to many records or rows in the table. These values can be
used to group data together and are often related to other values in other
columns in a hierarchical way.
A table can have many inherent hierarchies that indicate how these columns
are related. Defining these hierarchies as object trees is a useful method of
providing access to the table items to the Set Analyzer user who is not familiar
with the structure of the data. In Set Analyzer, the object trees do not have
to relate to a logical hierarchy, but can be constructed from any combination
of suitable objects in the set repository.

What is retention?
In the analysis of sets, retention is the number of stayers as a percentage
of the members at the end of the prior period.

SAP BusinessObjects Set Analysis User Guide

109

5

5

Set Analysis Terms
What is a sampling?

Related Topics

• What is a stayer?

What is a sampling?
A sampling is a group of the population with specified information. Ideally
you want to analyze a large sample frequently to get the most accurate
estimates and the most up-to-date information.
In Process Analysis, larger samples make it easier to detect small shifts and
make the control chart more sensitive in detecting changes without increasing
the rate of false alarms.
Note:

Start the sampling when data is available. If no data exists, the sampling can
take longer than necessary to generate.

What is segmentation?
In Set Analysis, segmentation is a way of partitioning a group of individuals,
for example customers, prospects, or suppliers, into categories referred to
as sets. Usually the groups are mutually exclusive, but they can overlap.

What is a stayer?
In the analysis of sets, a stayer is an individual who is present in a set in a
given period as well as the prior period.

What is a subject?
In Set Analysis, the subject defines the central theme for the sets which are
based on it. A set can contain data for only one subject; for example,
customers, accounts, products, etc. In the context of a customer subject,
you can define sets that include conditions based on the various tables and
views that describe the customer entity.
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What is turnover?
In the analysis of sets, turnover is the number of leavers as a percentage of
the members at the end of the prior period.
Related Topics

• What is a leaver?
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Information Resource

Location

SAP BusinessObjects product
http://www.sap.com
information

Select http://help.sap.com > SAP BusinessObjects.
You can access the most up-to-date documentation covering all SAP BusinessObjects products and their deployment
at the SAP Help Portal. You can download PDF versions
or installable HTML libraries.
SAP Help Portal

Certain guides are stored on the SAP Service Marketplace
and are not available from the SAP Help Portal. These
guides are listed on the Help Portal accompanied by a link
to the SAP Service Marketplace. Customers with a maintenance agreement have an authorized user ID to access
this site. To obtain an ID, contact your customer support
representative.
http://service.sap.com/bosap-support > Documentation
•
•

SAP Service Marketplace

Installation guides: https://service.sap.com/bosap-inst
guides
Release notes: http://service.sap.com/releasenotes

The SAP Service Marketplace stores certain installation
guides, upgrade and migration guides, deployment guides,
release notes and Supported Platforms documents. Customers with a maintenance agreement have an authorized
user ID to access this site. Contact your customer support
representative to obtain an ID. If you are redirected to the
SAP Service Marketplace from the SAP Help Portal, use
the menu in the navigation pane on the left to locate the
category containing the documentation you want to access.
https://boc.sdn.sap.com/

Developer resources

https://www.sdn.sap.com/irj/sdn/businessobjects-sdklibrary
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Information Resource

Location

SAP BusinessObjects articles https://www.sdn.sap.com/irj/boc/businessobjects-articles
on the SAP Community NetThese articles were formerly known as technical papers.
work

https://service.sap.com/notes
Notes

These notes were formerly known as Knowledge Base articles.

Forums on the SAP Communihttps://www.sdn.sap.com/irj/scn/forums
ty Network

http://www.sap.com/services/education
Training

From traditional classroom learning to targeted e-learning
seminars, we can offer a training package to suit your
learning needs and preferred learning style.
http://service.sap.com/bosap-support

Online customer support

The SAP Support Portal contains information about Customer Support programs and services. It also has links to
a wide range of technical information and downloads.
Customers with a maintenance agreement have an authorized user ID to access this site. To obtain an ID, contact
your customer support representative.
http://www.sap.com/services/bysubject/businessobjectscon
sulting

Consulting

Consultants can accompany you from the initial analysis
stage to the delivery of your deployment project. Expertise
is available in topics such as relational and multidimensional
databases, connectivity, database design tools, and cus
tomized embedding technology.
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